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Welcome to SmartPower

Welcome to SmartPower, Actel's state-of-the-art power analysis tool. SmartPower enables you to globally and in-
depth visualize power consumption and potential power consumption problems within your design, so you can make

adjustments — when possible — to reduce power.

SmartPower provides a detailed and accurate way to analyze designs for Actel FPGAs: from top-level summaries to
deep down specific functions within the design, such as gates, nets, IOs, memories, clock domains, blocks, and power

supply rails.

You can analyze the hierarchy of block instances and specific instances within a hierarchy, and each can be broken

down in different ways to show the respective power consumption of the component pieces.

SmartPower also analyses power by functional modes, such as Active, Flash*Freeze, Shutdown, Sleep, or Static,
depending on the specific FPGA family used. You can also create custom modes that may have been created in the

design. Custom modes can also be used for testing "what if" potential operating modes.

SmartPower has a very unique feature that enables you to create test scenario profiles. A profile enables you to create
sets of operational modes, so you can understand the average power consumed by this combination of functional
modes. An example may be a combination of Active, Sleep, and Flash*Freeze modes — as would be used over time in an

actual application.

SmartPower generates detailed hierarchical reports of the power consumption of a design for easy evaluation. This

enables you to locate the power consumption source and take appropriate action to reduce the power if possible.

SmartPower supports use of files in the Value-Change Dump (VCD) format, as specified in the IEEE 1364 standard,
generated by the simulation runs. Support for this format lets you generate switching activity information from
ModelSim or other simulators, and then utilize the switching activity-over-time results to evaluate average and peak

power consumption for your design.

SmartPower supports IGLOO, ProASIC3, SmartFusion, Fusion, ProASICELUS ProASIC, Axcelerator, and RTAX-S
families. If you are using any other family, the SmartPower button will not appear in your Designer window. For

information on future support for other device families, visit the Actel website at http://www.actel.com.

SmartPower v9.1 User’s Guide 7
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Starting SmartPower

Note: 'When you launch SmartPower, you must first set your target clock and data frequencies before you evaluate

your power consumption.

You cannot launch SmartPower if your design is not in a post-layout state in Designer. If you invoke SmartPower

before compiling your netlist, Designer guides you through the compile and layout process.
There are three ways to invoke the SmartPower analysis tool:

e Choose SmartPower from the Tools menu.

o Click the SmartPower icon in the Designer toolbar.

o  Click the SmartPower button in Designer design flow.

8 SmartPower v9.1 User’s Guide
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Figure 1 - SmartPower User Interface
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SmartPower Interface

Summary Tab

The Summary tab is divided into five sections: Power Consumption, Breakdown, Annotation Coverage, Operating

Conditions, and Battery Life.
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Figure 2 - SmartPower Summary Tab
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Power Consumption
Displays the total power consumption and the static and dynamic power of the design. (Accurate only after you have

entered your target clock and data frequencies).

Breakdown
Displays a breakdown of power consumption in the design. You can specify whether to see the power breakdown by

type of component, by voltage rail, or by clock domain from the drop-down list.

Show

Displays power usage as a chart or as a grid.

When you select By Type from the drop-down list, the Summary tab displays a breakdown of the design's power usage

by the following types:
e Net
e Gate
e I/0
e Memory

o Core Static
e Banks Static
e Analog (for Fusion Designs)

Any static power used by instances of a component in a design will be included in the appropriate category. As a result,
the sum of the power in breakdown by type will equal the total of the static and dynamic power consumption of the
design. Percentages displayed are fractions of the total power. Global nets are included in the net power types. To

obtain the power of a clock, select breakdown by clock domain.

When you select By Rail from the drop-down list, the Summary tab displays a breakdown of the power usage by the
rail that the power is drawn from and a breakdown for the current usage. For each rail, the power, voltage, and current

drawn are displayed.
When you select By Clock Domain from the drop-down list, the Summary tab displays a breakdown of the power

usage by the clock domain that the power is drawn from. For each clock domain, the power and percentage of power
drawn are displayed. Dynamic power is accounted for in breakdown by clock, but static power is not associated by any

clock.

When you select By Mode — available only when a scenario is selected in the Modes and Scenarios toolbar — the

Summary tab displays power consumption, duration and power duration weight by mode.

Whether you selected By Type, By Rail, By Mode, or By Clock Domain, you can customize which columns are
displayed in the grid by right-clicking the column headers. To exclude a column, remove its checkmark from the right-
click menu. Right-click a column header to set the column default size for the selected column or for all columns, sort

the values in ascending or descending order, or customize columns.

SmartPower v9.1 User’s Guide 11



| VActel

‘ SmartPower Interface

To sort the contents of a column, double-click a column header.

To export the contents of the grid to a file, from the File menu, choose Export Grid or click its associated toolbar

button.

To print the grid, from the File menu, choose Print Grid or click its associated toolbar button.

To copy the grid, from the Edit menu, choose Copy Grid or click its toolbar button.

To copy the chart, click the contents of the chart, and from the right-click menu, choose Copy Chart to Clipboard.
To export the chart, click the contents of the chart, and from the right-click menu, choose Export Chart to File.

To rotate the chart by 90 degrees, click the contents of the chart, and from the right-click menu, choose Rotate Chart
Clockwise or Rotate Chart Counter-Clockwise.

Annotation Coverage
Displays the number and percentage of pins annotated by each source (VCD, manual annotation, SmartTime
constraint, vectorless estimation, and fixed values) for all clocks, register outputs, combinational outputs, set/reset nets,

primary inputs, enable pins, and other pins.
To hide/show the annotation coverage, click the Hide annotation coverage or Show annotation coverage link.

Use the Annotation Coverage Summary drop-down menu to view probability or frequency annotation statistics

(frequency=0 shows statistics for pins that have a frequency of 0).
VCD: displays the number/percentage of pins with frequencies/probabilities imported from a VCD file.
Manual annotation: displays the percentage of pins with manually-annotated frequencies/probabilities.
SmartTime constraint: displays the percentage of pins initialized with SmartTime.
Fixed values: displays the percentage of pins with default frequency/probability.

Vectorless estimation: displays the percentage of pins that have been annotated with vectorless estimation.

Operating Conditions
Displays the temperature and voltage operating conditions for the selected mode or scenario as specified in the
Operating Conditions dialog box. When you select a scenario, the temperature and voltage operating conditions for
each mode in the scenario are displayed.
To change the operating conditions, click the Change Operating Conditions link or from the Tools menu, choose
Operating Conditions.

Battery Life
Enables you to set the battery capacity in mA/hr and reports the battery life.

12 SmartPower v9.1 User’s Guide



VActel

Domains Tab

Domains Tab

The Domains tab displays a list of existing domains with their corresponding clock and data frequencies and

probabilities.

When you start SmartPower for the first time, it will automatically initialize frequencies from SmartTime with a
default data toggle rate of 10%. However, if you update your timing constraints in SmartTime, you can use the

Initialize Frequencies and Probabilities dialog box to update SmartPower with new frequencies from SmartTime. If

you don't have timing constraints in SmartTime, you can manually initialize clock and data frequencies by directly

editing the Domains tab grid, or you can use the Initialize Frequencies and Probabilities dialog box.

If you import a VCD file, the Domains tab will display average clock and data frequencies for each clock domain and

input set. This average is calculated using VCD information.

Note: Note: If you change a clock or data frequency in the Domains tab, it will only impact nets using the default
estimation source. Nets use the default estimation source when they have not been manually set to a specific
frequency in the Frequencies tab, and when they have not been set by importing a VCD file. To see explicitly

the list of nets using the default estimation source, refer to the Frequencies tab.

%Summary ?@Domains |,Gﬂ Lnalysiz . QU Frequencies . e{}thahil'mes l

Shaw : " Probabilities
Clock domainz
Stat N Clocks Register setfReset | Primary inputs Combinational
(AT e (MHz} outputs nets {MHz) outputs {MHz}
1 o  |CLKIN 100 5 (10 %) 0 (0 %) 5 (10 %) 5 (10 %)
Hide et of ping
Set of ping
Data
Status Name Py (MHz)
1 N Input to Qutput il
Frequencies and Probabilities displaved in this tab are default values. They are uzed for nets that have nat been annotated by any methad [i.e. YCD' or manual
annotation]. Changing these walues may not impact power estimation, depending on the percentage of nets annotated.

Figure 3 - SmartPower Domains Tab

Note: Note: Data and clock frequencies are automatically set to zero when in non-active modes.

The Domains tab displays frequencies or probability data for clock domains and sets of pins. In this tab, you can add,

edit, or remove domains or sets of pins, and change the clock and/or data frequency of a selected domain.

To hide or display the grid for set of pins, click the Hide/Show set of pins link.

SmartPower v9.1 User’s Guide 13
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You can edit frequency or probability data directly from the grid.

To create a new clock domain or set of pins:

1. Right-click the clock domain or set of pins and choose to add a new create new clock domain or create new set of

pins.
2. Enter a name and click OK. The new clock domain or set of pins appears in the Domains tab.
3. Modify the frequency and probability data as needed.

Clock domain frequencies can be initialized by right-clicking the clock domain name and selecting Initialize
Frequencies and Probabilities. If there is no frequency constraint set for this clock domain in SmartTime, the clock

frequency of the domain will not be changed.

The status of a clock frequency or probability is displayed in the first column by an icon. Mouse over the icon to

identify the status:

Table 1 - Clock Frequency/Probability Status

Icon Description

,& This clock has not been initialized

No constraints available for this clock from SmartTime

Average frequencies/probabilities imported from VCD

Clock constraints imported from SmartTime

| |&]| P

This clock has been manually initialized

Note: Note: This feature is only available when in active operating mode or when in a mode based on the Active

mode.

The status of a set of pins is displayed in the first column by an icon. Mouse over the icon to identify the status:

Table 2 - Set of Pins Status

Icon Description

,& This set has not been initialized

i Average frequencies/probabilities imported from VCD

v"/ This set has been manually initialized

Note: Note: This feature is only available when in active operating mode or when in a mode based on the Active

mode.

14 SmartPower v9.1 User’s Guide
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To remove one or multiple clock domains, select the clock domain(s), and click Remove Selected Domains(s).

To edit a clock domain or a set of pins:
1. Select the clock domain and from the right-click menu, choose Edit Domain. The Clock Domain or Set-of-Pins

window appears.

CLESCIkT_reg:Q) Pins (Clock Domain)

Ay ping that do not belong o a domain are listed in the "Unclazzified Pins" lizt box. 'ou can select a
pirt from the 'Unclazsified Ping' izt box and add it to CLEACHK] _req:0.

Tou may alzo want zelect a pin frorm CLEACK _reg:@ and remove it from the domain [thiz pin will
appear in the Unclazzified Pins lizt bos).

Unclazsified Pins: |Clock Pins ~|
CLEALT08Y - E::Eﬁﬁ”g?ﬁgu

CREG/U3EY fdd = .

C5_M JE—

CTRLAITONY

CTRLAUTT:Y

CTRLAUT 20N

CTRLAUTZY 4 Remove
CTRLAUT4:Y

CTRLAS0N "

[ Set | Seleot Al § Set | Selectal |
Help aFk. Cancel |

Figure 4 - Clock Domain Window

Any pins that do not belong to a domain are listed in the Unclassified Pins list box. You can select a pin from the Unclassified

Pins list box and add it to the current domain. You may also select a pin from the current domain and remove it from the domain

(this pin will appear in the Unclassified Pins list box).

Clock Pins and Data Pins: Select Clock Pins from the pull-down list to display all clock pins for the selected domain, or select

Data Pins to display registers, asynchronous signals, primary input, and combinational signals for the selected domain.
Use the filter boxes to narrow your search for a specific pin. The boxes are text filters; * is a wildcard.

2. Click OK.

To delete a clock domain or a set-of-pins, select the clock domain or set-of-pins and from the right-click menu, choose

Remove Domain.
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Analysis Tab
The Analysis tab enables you to inspect detailed hierarchical reports of the power consumption. The Analysis tab

consists of two windows: the Hierarchy of Instances window and the Analysis window.

Paower Conzumption
Block Name:  fpga
Static Power:  0.156 v/
Dynamic Power:  13.473 mw

+-{F CTAL Breakdawr:  |By Type - Show ¢ Chat ¢ Grd

@ SREG lm Power Usage
@ CLE 0.033 miv'y

Core Static
@ CREG 01273 miv'y

Figure 5 - SmartPower Analysis Tab

Hierarchy of Instances Window
SmartPower displays the hierarchy of instances in a list in the Hierarchy of Instances window. Sub-blocks of a block

are shown in the tree when you click the plus sign (+) next to the block. Only hierarchical blocks are displayed in this
list (no gates or nets).
When you select a block of the hierarchical tree, SmartPower displays its name and power consumption in the Analysis

window.

Analysis Window

The Analysis window is divided into two sections: Power Consumption and Breakdown.

Power Consumption

Displays the name of the currently selected block from the hierarchy of instances window, as well as the static and

dynamic power consumption of the selected block.
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Analysis Tab

Show

Displays power usage as a chart (not available when breakdown by instance is selected) or as a grid.

Breakdown
Displays a breakdown of power usage of the currently selected block. Use the drop-down list to select whether to

display the power breakdown by type of component, instance, or clock domain.

When you select By Type from the drop-down list, the Analysis tab displays a breakdown of the selected block's power

usage by the following types:
e Net
e Gate
e 1/0
e Memory

e Core Static
e Banks Static

e Analog

Any static power used by instances of a component in a design will be included in the appropriate category. As a result,
the sum of the power in breakdown by type will equal the total of the static and dynamic power consumption of the
design. Percentages displayed are fractions of the total power. Global nets are included in the net power types. To
obtain the power of a clock, select breakdown by clock domain.

When you select By Clock Domain from the drop-down list, the Analysis tab displays a breakdown of the power usage
by the clock domain that the power is drawn from. For each clock domain, the power and percentage of power drawn
are displayed. Dynamic power is accounted for in breakdown by clock, but static power is not associated by any clock.
Whether you selected By Type, By Instance or By Clock Domain, you can customize which columns are displayed in
the grid by right-clicking the column headers. To exclude a column, remove its checkmark from the right-click menu.
Right-click a column header to set the column default size for the selected column or for all columns, sort the values in
ascending or descending order, or customize columns.

To sort the contents of a column, double-click a column header.

To export the contents of the grid to a file, from the File menu, choose Export Grid or click its associated toolbar

button.

To print the grid, from the File menu, choose Print Grid or click its associated toolbar button.

To copy the grid, from the Edit menu, choose Copy Grid or click its toolbar button.

To copy the chart, click the contents of the chart, and from the right-click menu, choose Copy Chart to Clipboard.
To export the chart, click the contents of the chart, and from the right-click menu, choose Export Chart to File.

To rotate the chart by 90 degrees, click the contents of the chart, and from the right-click menu, choose Rotate Chart
Clockwise or Rotate Chart Counter-Clockwise.
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To view an instance properties, right-click any instance and select Instance Properties. This brings the Instance

Properties window, which displays the instance name, type and power and other properties specific to each type of

instance, see image below.

Instance Properties E|
Property Yalue
Mame 141
Power Ot
Tvpe Gake
Macro ADLIE: IMNY
Pin Lisk:
Pir Mek | Domain | Freq. (MH2) |
U141:4 BusCukput CPUCH (data)  0.000
141y DRAMDaka ... CPUCHk {data) 0,000
Help Close
Figure 6 -

Figure 7 - Instance Properties: Gate

The Instance Properties allows you to access a list of pins of a gate and to check their domain and frequency.

See Also

Analyze results
Advanced Analysis of I/Os

Frequencies Tab

Use the Frequencies tab to attach switching frequency attributes to the interconnects of the design. The Frequencies

tab is divided into Switching Frequencies, Average Frequencies, and Annotation Statistics.
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%Summaw l i’\.@Dumains l _,Gﬁ.ﬂ.nalysis %Frequencies I%thahil'rbes ]

Frequencies Tab

Switching Freguencies:

Diriver. |* Set Dornain: | Al -

Source: |4l -

Driver Net Domain Fr?glelazl;cy Source 2
1 PWM_out_pad/U0A01:DOUT PWM_out_pad/J0/METL unl_dataa_int |0 Fixed values
2 PWM_out_pad/U0AU0:PAD  |PWM_out unl_dataa_int (0 Fized Values
3 nPWM_out_pad/U0/UL:DOU | nPWM_out_pad/U0/MNETL unl_dataa_int (0 Fixed Values
4 nPwM_out_pad/J0/00:PAD nPWM_out unl_dataa_int |0 Fixed Values
5 unl_dataa_int_ME:T unl_dataa_int_ME unl_dataa_int |0 Fized Values
&  PWM_out:Q P M_out_c unl_dataa_int |0 Fixed values
7 nPwWM_out:Q nPWwM_out_c unl_dataa_int (0 Fized Values
g | Aclr_pad/uosUo:y Aclr_pad/U0/NETL P _clk (sets |0 Fixed Values
3 PwM_clk P _clh P t_clk {cloc |0 Fixed values
10 PwM_clk_pad/uo/un:y Fwi_cllk_pad/J0/MET1 Fwi_clk {cloc |0 Fixed Values
11 PWM_data_in«5= PiM_data_in[5] Pt M_clle {prim|0 Fixed Values
12 PwWM_data_in«3= Puvt_data_in[3] P t_clk {prim|0 Fixed values b

Select al

Average Frequencies:

Fir:

Annotation Statistics:

WO Import; 0%

0 MHz I anual Annotation: 0%
Fized Values: 100 %
Yectarless Estimation: 0%

Figure 8 - SmartPower Frequencies Tab

Switching Frequencies

Displays the pins and lists the net, domain, frequency, and frequency source for each pin.

The Driver box enables you to filter the list of pins based on the criteria entered. Enter text in the filter box, and click

Set to apply this text as a filter. Use the * character to display all pins or as a wildcard.
Use the Domain drop-down list to select a different domain (All, CLKIN, Default, or Input to Output).
Use the Source drop-down list to select a different source (All, Default, Manual Annotation, or VCD Import).

You can change the frequency by entering a new value in the Frequency column or by selecting multiple pins and
pressing the Set frequencies for selected pins button and entering a new frequency. Use Reset frequencies for selected

pins to revert to the default frequency.

To select all the pins, click Select All.

Average Frequencies

Displays the average frequency of all pins displayed in the grid.
Average Frequencies are useful when you import a VCD file or SAIF file. Since these files enable you to specify the

frequency of each pin individually, it is often useful to know the average clock pin or data pin frequency for a particular

clock domain.
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If you did not specify a frequency annotation for any clock pin in this clock domain, the average value is equal to the
default clock frequency of the clock domain. If you set one or several clock pins, SmartPower takes these specific

annotations into account to compute an average value.

If you did not specify a frequency annotation for any data pin in this clock domain, the average value is equal to the
default data frequency of the clock domain. If you set one or several data pins, SmartPower takes these specific

annotations into account to compute an average value.

Annotation Statistics

VCD import: displays the percentage of pins with frequencies imported from the *.ved file.
Manual annotation: displays the percentage of pins with manually-annotated frequencies.

Fixed values: displays the percentage of pins with default frequency.

Probabilities Tab

You can use the Probabilities tab to control the probabilities for all pins.

Bidirectional and Tristate I/Os: Controls the output probability of each tristate and bidirectional I/O. The probability
is the percent of time that the I/O is used as an output. You can change the default value and set a specific value for

each bidirectional or tristate I/O.

Memories: Controls the read cycle probability or the write cycle probability of a memory block. The probability is the
percent of time that a memory block will be used either in a read cycle or a write cycle. You can change the default

value as well as set a specific value for each enable pin of each memory block available in the design.

If an enable pin is active low, assign it a probability of 0% to completely enable the I/O or the memory block, or 100%

to disable it completely.

In designs with a cascaded memory, all memory enable pins are shown in the Probabilities tab. To simulate real-world
power consumption, selectively enable only some memory enable pins, as specified in the memory cascading structure.
For purely vertical cascading, enable the pins belonging to one RAM block. For purely horizontal cascading, enable all
pins belonging to all RAM blocks of the cascaded memory. You can find which RAM block corresponds to which pin
by cross-probing with the MVN NetlistViewer.

Power consumption values predicted by SmartPower may be overestimated for Axcelerator and RTAX-S/SL devices.
Axcelerator and RTAX-S/SL devices have automatic depth cascading, which is not accounted for in the current
version of SmartPower. A more accurate value for memory power consumption may be achieved by dividing the
probability by the level of depth cascading. To simulate a 2048x9 RAM and a cascading level of 2048/512 = 4 with a
probability of 40%, enter 40/4 = 10%. Similarly, to simulate a 1024x9 RAM with a 100% probability, enter a
probability of 50%.

Note: Note: SmartPower does not support custom probabilities for asynchronous RAMs and FIFOs for ProASICELUS

devices.

The Probabilities tab displays the drivers, nets, types, polarity, rates, and source for each pin.
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Probabilities Tab

Probability Source

Polarity (%)

- 99.9949
- 99,9949
- 99,0949
- 0

000003
000003
000003

000003
000003

000003
0125

0125
ni7E

Driver: | Set Type: &l - Palarity: {20 - Source:
Driver Net Type

1 rst_n rst_n Input to

z rst_n_padU0/00:Y rst_n_pad/U0/METL Input to

3 rst_n_pad/J0/010r rst_n_c Input to

4 fpu_op<0= fpu_ap[0] Input to

5 fpu_op_pad[0] U000y (fpu_op_pad[0]/J0/METL | Input to

3 fpu_op_pad[0]/U0/uL:y  |[fpu_op_c[0] Input to

7 UUT unl_fpu_op_3_0_aZ2 UUT/M_1112 Input to

g UUTAracta_rmul_w_0_az |UUTAM_1111 Input to

a fpu_op<1= fpu_op[1] Input to

10 fpu_op_pad[1]/U0/U0:v  (fpu_op_pad[1]/U0/MET1 | Inpout to

11 fpu_op_pad[1]/U0/0L:  |[fpu_op_c[1] Input to

1z UUTAunl_fpu_op_1_0_a2 UUTAM_10Z26 Input to

13 fpu_op<z= fpu_op[2] Input to

14 fpu_op_pad[2]/00/00:  |[fpu_op_pad[2]/U0/METL | Input to

15 fpu_op_pad[2]/U0/0L:Y  |[fpu_op_c[2] Input to

16 LT Aract_denorm[30]: 0 | ULTAract_denormm[30] | UUT un3_out_
17 UUTAract_denarm[32]:Q |UUTHract_denorm[32]  |UUT/un3_out_
1 1T Herard darmrrs 21T T HITHesmt dammeesl211 THIT A im2 Ak

'
'
20000000000 ooo

Figure 9 - SmartPower Probabilities Tab

Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A
Manual A

Manual A
M=ru=l A

Select al

The Driver box enables you to filter the list of drivers based on the criteria entered. Enter text in the filter box, and

click Set to apply this text as a filter. Use the * character as a wildcard.

Use the Type drop-down list to filter the pin list by different type (All, All enable, CLKIN, Default, or Input to

Output).

Use the Polarity drop-down list to filter the pin list by polarity (Low, High, or All).

Use the Source drop-down list to filter the pin list by source (All, Default Estimation, Manual Annotation, Saif

Import, or VCD Import).

You can change the rate by entering a new value in the Rate column or by selecting multiple pins, pressing the Set

Probabilities for selected pins button, and entering a new frequency in the Set Default Probabilities dialog box.

Set probability for pin(s)

Probability:

3

| SN

O | Cancel |

Figure 10 - Set Probability for Pins Dialog Box

Use Reset Probabilities for selected pins to revert to the default polarity.
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You can change the default probability from the Domains tab.
To select all the drivers, click Select All.

You can set or reset the probabilities, set a default probability, copy, export, or print the grid by selecting one or

multiple pins and choosing an option from the right-click menu.

See Also

Specify probabilities

Preferences Toolbar

The SmartPower Preferences toolbar gives you quick access to commonly used settings. Mouse over the toolbar button

to view a description of the command. Use the drop-down list to select your settings.

Operating Frequency Powwar
Conditions Preferances Praferences
Typical | ||MHz It I L B |

Figure 11 - SmartPower Preferences Toolbar
Operating Conditions: Enables you to set the operating conditions - Best, Typical, or Worst.

The actual voltage and temperature of a given operating condition is defined by the operating condition range selected
for the current design (COM, IND, MIL, Auto, TGradel, TGrade2, and Custom). For SmartPower, unlike
SmartTime, the worst voltage is the upper bound of the range. That is, higher (worst-case) power comes from higher

voltage, whereas higher voltage results in best-case speed.
Note: Note: Worst-case and best-case calculations are available only for certain families and devices.
Frequency: Sets unit preferences for frequency — Hz, KHz, MHz.

Power Units: Sets unit preferences for power — W, mW, or uW.

See Also

SmartPower toolbar / menu commands

Modes and Scenarios Toolbar

The Modes and Scenarios toolbar displays all pre-defined modes, custom modes, pre-defined scenarios, and custom
scenarios. The Modes and Scenarios toolbar is shown by default, but can be closed or undocked. To view the toolbar,

from the View menu, choose Modes and Scenarios toolbar.
From this toolbar, you can:
e Select a pre-defined mode by clicking the mode name

o Select a custom mode by clicking the mode name
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Modes and Scenarios Toolbar

e Select a custom mode for power-driven layout by right-clicking the active-based mode and selecting Use for

PDPR

e Re-import a VCD file from an Active mode or a custom mode by right-clicking the VCD file and selecting Re-
import VCD File

e Remove a VCD file from an Active mode or a custom mode by right-clicking the VCD file and selecting
Remove VCD File from <mode name> Mode; or from the Simulation menu, choose Remove VCD File > <file

name>

e Generate a Cycle-Accurate Power report by right-clicking the VCD file and selecting Cycle-Accurate Power
Report

e Generate an Activity and Hazards Power report by right-clicking the VCD file and selecting Activity and
Hazards Power Report

e View the Cycle-Accurate Power analysis by right-clicking the VCD file and selecting Cycle-Accurate Power
Analysis
e Create a new custom mode by clicking Custom modes and selecting New Custom Mode; or by clicking the New

Custom Mode hyperlink

e Edit and delete a custom mode by right-clicking the mode name and selecting Edit custom mode or Delete

custom mode
e Copy a custom or a pre-defined mode by right-clicking the mode name and selecting Create a copy of this mode
o Select a scenario by clicking the scenario name

e Create a new custom scenario by clicking Scenarios and selecting New custom scenario

e Edit and delete a custom scenario by right-clicking the scenario name and selecting Edit custom scenario or

Delete custom scenario
e Copy a scenario by right-clicking the scenario name and selecting Create a copy of this scenario

Note: Note: When a scenario is selected, only the Summary tab is available.
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Modes and scenarios x
Pre-defined mades
[ Active
Static
Flazh*Freeze
Sleep
Custom modes
active_low
Pre-defined scenarios
A0% Flazk*Freeze
80% Flazk*Freeze
5% Flash*Freeze
Custorn scenanios
[owpower

Figure 12 - Modes and Scenarios Toolbar

SmartPower Standard Toolbar and Menu Commands

The SmartPower standard toolbar contains commands for performing common SmartPower operations on your
designs. Roll the mouse pointer over the toolbar button to view a description of the button. Click the button to access

the command.

Table 3 - SmartPower Toolbar

Toolbar Button Description

Commit

Settings Summary

@ | ©

= Operating Conditions

Options

Export Path Grid

g

Copy Path Grid

i

Print Grid

Generate Power Report

B | [
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Toolbar Button

Description

G

Initialize Frequencies and Probabilities

o Refreshes Vectorless Estimation
The PC and UNIX workstation versions of SmartPower have the same menus. However, some dialog boxes may look
slightly different on the two platforms due to the different window environments. The functionality is the same on
both platforms, though the locations of the fields and buttons on the dialog boxes may vary. The names of some fields
may also vary between the PC and workstation versions.
File Menu
Menu Description

Commit Commits power information to Designer. You must commit your changes if you

wish to save your settings in SmartPower. If you commit your changes, the

information is stored in the .adb file, and your settings are restored the next time

you open your design in SmartPower
Export Exports the selected area of the Report window to a text (.txt) file
Grid
Print Grid | Prints the selected area of the Report window
Settings Displays a summary of the power settings for the current design
Summary
Close Closes SmartPower
Edit Menu

Menu Sub-Menu Description
Domains New Clock Domain Adds a clock domain
New Set of Pins Adds a set of pins

Delete Domain

Deletes a clock domain

Edit Domain

Edits a clock domain

SmartPower v9.1 User’s Guide
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Menu Sub-Menu Description
Modes and Use for Analysis > mode or Sets the selected mode or scenario to be used
Scenarios scenario name for analysis
Use for PDPR > mode or Sets the selected mode or scenario to be used
scenario name for Power-Driven Layout
Custom Modes > New Creates a new custom mode
Custom Mode
Custom Modes > Edit Edits a custom mode
Custom Mode
Custom Modes > Delete Deletes a custom mode
Custom Mode
Custom Scenarios > New Creates a new custom scenario
Scenario
Custom Scenarios > Edit Edits a custom scenario
Scenario
Custom Scenarios > Delete Deletes a custom scenario
Scenario
Copy Grid — Copies the selected cells of the dynamic grid
onto the clipboard

View Menu

Menu

Description

Standard Toolbar

Displays or hides the SmartPower Standard toolbar

Preferences Toolbar

Displays or hides the SmartPower Preferences toolbar

Modes and Scenarios Toolbar

Displays or hides the Modes and Scenarios toolbar

Toolbar

Unprocessed Simulation Files

toolbar

Displays or hides the Unprocessed Simulation Files

26

SmartPower v9.1 User’s Guide



VActel

SmartPower Standard Toolbar and Menu Commands

Menu Description

Customize Columns Selects and orders the columns displayed in the user

interface

Reset Window Layout Resets the window layout to the default layout

Tools Menu

Menu Sub-Menu Description

Initialize Frequencies | — Imports clock constraints from SmartTime and
and Probabilities enables the user to input frequencies and

probabilities for the design

Operating Conditions | — Enables the user to customize the operating

conditions used in SmartPower

Options — Invokes the Options dialog box, where you can set
analysis and display preferences
Reports Power Report Generates a power report

Scenario Power

Report

Generates a scenario power report

Cycle Accurate

Power Report

Generates a cycle accurate power report

Activity and
Hazards Power

Report

Generates an activity and hazards power report

Cycle Accurate Power

Analysis

Generates a cycle-accurate power analysis

Simulation Menu

Menu

Description

SmartPower v9.1 User’s Guide
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Menu Description
Import VCD File Invokes the Import VCD Options dialog box
Remove VCD file Removes the selected CVD file from the design
Audit files Audits simulation files within the project
Help Menu
Menu Description

Help on current tab

Displays the help content for the current tab

Help Topics

Opens the help files for SmartPower

SmartPower User's Guide

Displays the SmartPower User's Guide

Data Change History

Displays the data change history report

See Also

SmartPower preferences toolbar

Power - Settings Summary

The Power - Settings Summary dialog box displays a summary of the power settings for the current design.

VActel

To open the Power - Settings Summary dialog box, from the File menu, choose Settings Summary or click the

icon in the SmartPower toolbar.
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Initializing Frequencies and Probabilities

Power - Settings Summary I

X

Attribute Walue
Dezign SMALL_GATED
Farnily FrodS5IC3
Die A3P125
Fackage 144 FEGA
Temperature Range COM
Yoltage Range COM
Operating Conditions Typical
Operating Mode Active

ok |

Figure 13 - Power - Settings Summary Dialog Box

Design: Displays the name of the design.

Family: Displays the device family used in the design.
Die: Displays the die.

Package: Displays the package.

Temperature Range: Displays the temperature range.

Voltage Range: Displays the core supply voltage.

Operating Condition: Displays the operating conditions that SmartPower uses to calculate static and dynamic

power contributions.

Operating Mode: Displays the operating mode that SmartPower uses to calculate static and dynamic power

contributions.

Note: Note: The status bar also shows the ambient temperature, VCCA and speed grade.

Initializing Frequencies and Probabilities

The Initialize Frequencies and Probabilities dialog box enables you to initialize the frequencies and probabilities for

your design.

To open the Initialize Frequencies and Probabilities dialog box, from the Tools menu, choose Initialize Frequencies

and Probabilities, or click the

icon in the SmartPower toolbar.

SmartPower v9.1 User’s Guide
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Note: Note: This feature is only available in the Active operating mode or modes derived from the Active mode.

The dialog box is organized in the following panels: General, Clocks, Register Outputs, Set/Reset Nets, Primary

Inputs, Combinational Outputs, Enables Sets of Pins, and Other Sets of Pins.

General
SmartPower - Initialize Freguencies and Probabilities
Selecta Category:
@ eneral Use this dialog box o initialize Frequencies and probabilities For your design.
Ul Clocks
i Register oukputs Initialize mode: | Active ﬂ 1]
T, SetfReset nets
> Primary inputs o Far pins that have not been annotated, SmartPower can estimated their
o frequency and probability using a Yectorless analvsis ar fixed values,
T Combinational cutputs
. Sek of pins
Enables v Use vectorless analysis
Others
" Use fixed values
[ Remove Simulation file (WCD0 F any.
[ Remove any manual annokations.
Help QK | Cancel
Figure 14 -

Figure 15 - Initialize Frequencies and Probabilities Dialog Box — General

Initialize mode — Select an active-based mode to initialize the frequencies and probabilities for.

For pins that have not been annotated, SmartPower can estimate their frequency and probability using vectorless

analysis or fixed values:
Use vectotless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis.

Use fixed values — SmartPower initializes frequencies and probabilities (%) of all registers with a default toggle rate

(available only when using toggle rates), frequency, and probability.

Based on the selected mode, a warning appears with information on the annotated pins. If the selected mode contains

any annotations, you can remove annotations by selecting one or both options below:
Remove simulation file (VCD) if any — Select this option to remove the simulation file for the selected mode.

Remove any manual annotations — Select this option to remove all manual pin annotations for the selected mode.
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Clocks

SmariPower - Initialize Frequencies and Probabilities

@l General

UL Clocks
ir Reqister outpuks
‘T, Set/Resst nets
= Primary inputs
I+ Combinational outputs
. Set of pins
Enables ¥

Cth
ers W else, with default frequency 10,00 1MHz

and duby cycle 50,00 o,

v Initizlize dock frequencies and duty cycles

Help Ok, | Cancel

Figure 16 - Frequencies and Probabilities Dialog Box — Clocks

Initialize clock frequencies and duty cycles — Select this option to initialize clock frequencies and duty cycles, with:
with clock constraint if available in SmartTime: When only this box is checked, SmartPower initializes all clock
domains in SmartPower with clock constraints from SmartTime. If there is no frequency constraint set for this clock
domain in SmartTime, the clock frequency of the domain will not be updated.
else, with default frequency (MHz) and duty cycle (%): When only this box is checked, SmartPower initializes all
clock domains in SmartPower with the specified default frequency and duty cycle.

Note: Note: When both boxes (with clock constraint if available in SmartTime and with default frequency and duty
cycle) are checked, SmartPower initializes all clock domains with clock constraints from SmartTime. If there
is no frequency constraint set for a clock domain in SmartTime, it is initialized with the specified default

frequency and duty cycle.
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Register Outputs

SmariPower - Initialize Frequencies and Probabilities

@l General

UL Clocks

lv Initialize frequencies and probabilities

= Primary inputs

I+ Combinational outputs + with Yectorless analysis
. Set of pins ~
Enables
Cthers

T
T

Help Ok, | Cancel

Figure 17 - Frequencies and Probabilities Dialog Box —Registers

Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for register outputs

in your design.
With vectorless analysis — SmartPower initializes frequencies and probabilities using vectorless analysis.

With fixed values: SmartPower initializes frequencies and probabilities (%) of all register outputs with a default
toggle rate (available only when using toggle rates) or frequency (when not using toggle rates), and a default
probability.
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SmariPower - Initialize Frequencies and Probabilities

<R

@l General

UL Clacks
ir Reqister outpuks

Set/Reset nets

Help

= Primary inputs

I Combinational autputs v Initislize frequencies and probabilities
. Set of pins
Enables with fixed toagle rate 0,00 o
Cthers

with fixed probability 50,00 e

Ck | Cancel

Figure 18 - Frequencies and Probabilities Dialog Box — Asynchronous

Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for set/reset nets in

your design.

With default toggle rate (%): SmartPower initializes frequencies and probabilities of all set/reset nets with

the specified default toggle rate. This option is available only when using toggle rates.

With default frequency (MHz): SmartPower initializes all set/reset nets in SmartPower with the specified default

frequency. This option is available only when not using toggle rates.

With default probability (%): SmartPower initializes probabilities of all set/reset nets with the specified default

probability.
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SmariPower - Initialize Frequencies and Probabilities

@l General

UL Clacks
ir Reqister outpuks
‘T, Set/Resst nets
e Crimary inpuks
I Combinational autputs v Initislize frequencies and probabilities
. Set of pins

Enables with fixed toggle rate 10,00 o
Others
with fixed probability 50,00 %

Help Ok, | Cancel

Figure 19 - Frequencies and Probabilities Dialog Box — Primary Inputs
Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the primary

inputs in your design.
With default toggle rate (%): SmartPower initializes frequencies and probabilities of all primary inputs with the
specified default toggle rate. This option is available only when using toggle rates.
With default frequency (MHz): SmartPower initializes all primary inputs in SmartPower with the specified default
frequency. This option is available only when not using toggle rates.
With default probability (%): SmartPower initializes probabilities of all primary inputs with the specified default
probability.
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Combinational Outputs

SmariPower - Initialize Frequencies and Probabilities

Select a Categony: Combinational outputs

@l General

UL Clocks
ir Reqister outpuks
‘T, Set/Resst nets o _ »
& Primary inputs lv Initialize frequencies and probabilities
B Comnbinational outputs
. Set of pins ~
Enables
Cthers

% with Yectarless analysis

T
T

Help Ok, | Cancel

Figure 20 - Frequencies and Probabilities Dialog Box — Combinational

Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the

combinational outputs in your design.

With vectorless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis.

With fixed values: SmartPower initializes frequencies and probabilities (%) of all combinational outputs with a

default toggle rate (available only when using toggle rates) or frequency (when not using toggle rates), and a default

probability.
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Enables

SmariPower - Initialize Frequencies and Probabilities

@l General

UL Clocks
4 Register outputs Iv Initialize frequencies and probabilities
‘T, Set/Resst nets

= Primary inputs {* with Yectorless analysis

I+ Combinational outputs .
. Set of pins
ables D - Frequency Probability
omain MHz %
Others 1 10sEnableSet 0,00 12 50
Z MemoriesEnableSet 0.00 12 .50

Help Ok, | Cancel

Figure 21 - Frequencies and Probabilities Dialog Box — Enables
Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the enable sets

of pins in your design.
With vectorless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis.
With fixed values: SmartPower initializes frequencies and probabilities of all enables sets of pins with the specified

default probability and frequency.

36 SmartPower v9.1 User’s Guide



VActel

Power Options

Others

SmariPower - Initialize Frequencies and Probabilities

@l General

UL Clocks
ir Reqister outpuks
‘T, Set/Resst nets
= Primary inputs

[v Initizlize frequencies and probabilities

(¥ with Yectorless analysis

I+ Combinational outputs primary inputs frequency | 1.00 MHz
i Set of p::ls primary inputs probability | 50,00 %o
Enables

T
T

Help Ok, | Cancel

Figure 22 - Frequencies and Probabilities Dialog Box — Others

Initialize frequencies and probabilities — Select this option to initialize frequencies and probabilities for the other sets
of pins in your design with default values.

With vectorless analysis — SmartPower initializes frequencies and probabilities with vectorless analysis as specified in

the primary inputs frequency and probability.

With fixed values: SmartPower initializes frequencies and probabilities (%) of all other sets of pins with a default

frequency and probability.
See Also
Domains Tab

Vectorless Analysis

Power Options

Enables you to set options that affect the graphical and textual reports.
To open the SmartPower Power Options dialog box:
e From the File menu choose Options

e Select the Options panel in the Power Report dialog box.

e C(Click the icon in the SmartPower toolbar.
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Power - Options

x]

Uitz

FPawer: miv | E
Frequency MHz s

v Lze toggle rates

Help | ak. Cancel |

Figure 23 - SmartPower Preferences Dialog Box
There are two sections: Units and Use Toggle Rates.

e Units: Sets unit preferences for power (W, mW, vW) and frequency (Hz, KHz, MHz).

e Use Toggle Rates: When toggle rates are active (Use Toggle Rates box is checked), the data frequency of all the
clock domains is defined as a function of the clock frequency. This updates the data frequency automatically
when you update the clock frequency. Toggle rates enable you to specify the data frequency as a percentage of
clock frequency, but you can no longer specify the data frequency as a number, only as a percentage of the clock

frequency. To specify data frequencies, clear the Use Toggle Rates option in the Preferences window.

You can set the data frequency percentage when you create a new clock domain with toggle rates active. In addition,

when toggle rates are active you can set the data frequency percentage in the Domain and Frequencies tabs.

Create Clock Domain

Cieat
Patertial Clock Pin SRR ks

Clack Frequemncy I 10 MHz
Data Frequency I 20 X

Figure 24 - Create Clock Domain — Toggle Rates Enabled

di

Cancel

Operating Conditions

The SmartPower Operating Conditions dialog box enables you to customize the operating conditions used in

SmartPower for voltage and temperature.

Note: Note: Changes will apply only to SmartPower and will not change the operating conditions set in Designer.
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The General panel enables you to select the operating condition you want to apply to SmartPower: Best, Typical, or
Worst.

SmartPower - Operating Conditions

Selecta Category
@ General

f Temperature settings

+ Thermal resistance settings IJse this dialog box to customize the operating conditions used in SmarkPower,

[} Woltage settings Changes will apply only to SmattPower and will not change the operating conditions
YOO set in Designet,

WCOCI 2.5
YOOI 33
WCCI L8

YOOI LS Select an active operating condition For

SmartPower From the options below:

Help Ok, | Zancel

Figure 25 - SmartPower Operating Conditions Dialog Box - General
You can customize temperature settings in the Temperature Settings panel, and the voltage settings in the Voltage

Settings panels — each VCC voltage used in the design appears under Voltage settings.
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ower - Operating Conditions

Select a Categorny: Temperature settings
@ General
f e Lse: ign operating range {default)
.*. Thermal resistance settings SmartPower uses the operating range specified in the Device Selection Wizard:
. This design uses "COM" settings.
[} Yaoltage sektings
WOCA
WOCI 2.5
WOCI 3.3
WOCI 1.8
WOCI1.5

Junction Temperature (in degrees Celsius)

Best: Typical: Worst:

Help Ok, | Zancel

Figure 26 - SmartPower Operating Conditions Dialog Box - Temperature Settings

Select one of three options to specify the temperature or voltage settings:

¢ Design operating range (default): sets the temperature or voltage operating range as specified in the Device

Selection Wizard in Designer.

¢ Custom operating range: scts the temperature (junction or ambient) or voltage operating range for the current

design in SmartPower only. You can enter temperature values in degrees Celsius and voltage values in volts for
Best, Typical, and Worst.

¢ Mode by mode operating range: sets the temperature (junction or ambient) or voltage for each mode in
SmartPower only. You can use the grid to enter temperature values in degrees Celsius and voltage values in volts
for each mode, or select multiple modes in the grid, and click the Set values for selected modes button to enter

the same values for all selected modes.
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SmartPower - Operating Conditions

Select a Categorny: Temperature settings

@ General

f e e Use: |Mode by mode operating range j
.*. Thermal resistance settings SmartPower uses a different operating range For each mode.
[} | . Operating ranges For each mode can be specified below. They apply to SmartPower only.
Voltage settings Specify {in Celdius degrees):
WCCA {* Junction Temperature
WCCI 2.5 " Ambient Temperature
WOCI 3.3
WOCT 1.8 Mode Best Typical Worst
WOCI1.5 :
1 Active 0.00 25.00 70.00
2 Sleep 0.00 25.00 50.00
3 Static 0o 25.00 50.00

‘ Select all
Help Ok, | Zancel ‘

Figure 27 - SmartPower Operating Conditions Dialog Box - Mode-Specific Temperature Settings

The junction temperature and static power are computed iteratively until they converge.

The formulas are:

T = T/;+ U_,FA‘ ) (Prﬁwﬂ.ﬂlrrr IPﬂ'e?.".'r}
Poi=f (T;) =Py + Py T,

If the computed junction temperature is outside the operating condition range (smaller than the best case value or

greater than the worst case value), a violation warning will be reported.
Both T) and P.u. will be re-computed when any of the following parameters are changed:
e Ambient temperature
e Cooling style
e Custom thermal resistance,
or any parameters/options that affect the static or dynamic power values:
e Junction Temperature Display Mode
e Operating Condition (Affect dynamic power)
e Operating Mode (Affect dynamic power)

¢ Any of the clock domain frequencies (Affect dynamic power)
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If you specified the Ambient temperature in the Temperature Settings panel, you can select the thermal characteristic
for Thetaja .

SmartPower - Operating Conditions

@ General

f Temperature settings

'*' Thermal resistance settings
[} Yaoltage sektings

WA
WoCI 2.5 Select the thermal characteristic for G,
WoZI 33
* Pre-defined: 13.6 Cfw
WIS
YOOI 1S " Cuskam:

Help Ok, | Zancel

Figure 28 - SmartPower Operating Conditions Dialog Box - Thermal Resistance Settings

The thermal resistance is predefined for Still Air, 300 ft/min and Case Cooling. To enter a custom thermal resistance,

select Custom from the Cooling field, and change the value.

SmartPower also reports the thermal resistance, Theta

See Also

SmartPower toolbar / menu commands

SmartPower preferences toolbar

Custom Operating Modes

SmartPower enables you to use pre-defined and custom operating modes. A pre-defined operating mode is an inherent
mode of a family of devices that comes with a number of hard availability constraints on the FPGA resources. Custom
operating modes are user-defined modes based on one of the pre-defined modes available for the family, where
parameters such as clock, data, and toggle rate frequencies have been customized. A custom mode can also be linked to

a VCD.

Custom modes can be used:

e To define additional modes where the chip is in the active pre-defined mode, but where the clock frequencies or

the toggle rates are scaled up or down.

e To import multiple VCD files that capture individual steps that take place in different modes.
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e To define a sequence of modes with a duration for each mode and get an estimate of the overall power
consumption, from which extrapolate the battery life for the application. The Scenario Power report enables you

to define a sequence of modes and estimate the weighted average of the power consumption of the chip over the

whole sequence.

e To define additional modes where the chip is in a pre-defined mode, but the junction/ambient temperature or

the rails' voltage modes are different.

To set the current mode:
From the Edit menu in SmartPower, choose Modes and Scenarios > Use for Analysis > mode name; or select the mode

in the Modes and Scenarios toolbar.

To create a new custom mode:
1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Modes > New Custom Mode; or

click Custom Modes in the Modes and Scenarios toolbar, and select New custom mode. This brings up the New

Custom Mode dialog box.
Power, - New Custom Mode E'
Marne: | Mode3
Based on mode: |.ﬁ.|:tive j
Comment:

| Frequency 15 MHz|

Help (04 | Cancel |

Figure 29 - New Custom Mode Dialog Box

2. Enter the mode name, select the base mode, and enter comments that describe the mode. The base mode can be

either a user-defined custom mode or the active mode. The new mode will inherit all clock and data frequencies

and annotations of its base mode.
3. Click OK. The newly created operating mode is set as default in the Modes and Scenarios toolbar.

To edit a custom mode:
1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Modes > Edit Custom Mode; or
right-click the mode in the Modes and Scenarios toolbar, and select Edit custom mode. This brings up the Edit
Custom Mode dialog box.
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Power - Edit Custom Mode [custom_mode] E'

Marne: cuskar_mode

Carrmenk:

| Copied from "3lesp”

This mode is derived From the "Sleep” low power mode.

Help Ik | Cancel

Figure 30 - Edit Custom Mode Dialog Box

2. Edit the mode name and comments.
3. Click OK.

Note: Note: You can only use the Edit Mode dialog box to edit the name and comment of the current mode. To edit

the mode properties such as clock and data frequencies, use the SmartPower tabs.

To copy a custom mode:
1. Right-click the mode in the Modes and Scenarios toolbar, and select Create a copy of this mode. This brings up
the New Custom Mode dialog box.

Power, - Mew Custom Mode [Z|
Name: Copy of Active
Based on mode: |F'.|:I:ive ﬂ
Comment:

| Copied from "Active"

Help Ik | Cancel |

Figure 31 - New Custom Mode Dialog Box

2. Edit the mode name and comments.

3. Click OK.

To delete a custom mode:

1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Modes > Delete Custom Mode; or
right-click the mode in the Modes and Scenarios toolbar, and select Delete Mode. This brings up the Delete
Custom Mode dialog box.
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Power, - Delete Custom Mode

X

Choose the cuskom mode to delete:

Modes

Help K, | Cancel

Figure 32 - Delete Custom Mode Dialog Box
2. Select the mode from the pull down and click OK.

Note: Note: You can only delete custom operating modes. Pre-defined modes cannot be deleted.

Scenarios

A scenario is a sequence of previously defined operating modes with a specific duration for each mode. When you
create a new design, SmartPower will automatically create some pre-defined scenarios that can be used as is, or copied

to create a new scenario based on the pre-defined one.

Note: Note: Pre-defined scenarios cannot be deleted or edited.

To set the current scenario for analysis:
From the Edit menu in SmartPower, choose Modes and Scenarios > Use for Analysis > <scenario name>; or select the

scenario in the Modes and Scenarios toolbar.

Note: Note: When a scenario is selected, only the Summary tab is available.

To create a new custom scenario
1. TFrom the Edit menu in SmartPower, choose Modes and Scenarios > Custom Scenarios > New Custom
Scenario; or click Scenarios in the Modes and Scenarios toolbar, and select New custom scenario. This brings up

the New Custom Scenario dialog box.

2. Enter the scenario name, enter a duration (total duration for the sequence must equal to 100%) and select

previously defined operating modes for this sequence.
3. Click OK. The newly created scenario is set as default in the Modes and Scenarios toolbar.

To edit a custom scenario:
1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Scenarios > Edit Custom Scenario;
or right-click the scenario in the Modes and Scenarios toolbar, and select Edit custom scenario. This brings up

the Edit Custom Scenario dialog box.
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Power - Edit Custom Scenario [Copy of 50% Flash*F... |

Duration [¥] Mode
A0 Active
a0 Flazh*Freeze

(o Dt e p ) I S B

Total: 100 %

(IR

Comment:

| Copied From "S0% Flash*Freeze"

Help | K | Cancel |

Figure 33 - Edit Custom Scenario Dialog Box

2. Edit the information.
3. Click OK.
To copy a scenario:

1. Right-click the scenario in the Modes and Scenarios toolbar, and select Create a copy of this scenario. This

brings up the New Custom Scenario dialog box.
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Power - Mew Custom Scenario

Marne:

Duration [¥] Mode
20 Active
an Sleep

(o Dt e p ) I S B

~
s
Total: 100 %

Comment:

| Copied Fram "scenariol”

Help | K | Cancel |

Figure 34 - New Custom Scenario Dialog Box

2. Edit the information.
3. Click OK.
To delete a custom scenario:
1. From the Edit menu in SmartPower, choose Modes and Scenarios > Custom Scenarios > Delete Custom

Scenario; or right-click the scenario in the Modes and Scenarios toolbar, and select Delete Scenario. This brings

up the Delete Custom Scenario dialog box.

Power - Delete Custom Scenario E'

Choose the custom scenario to delete;

Help (4 | Cancel

Figure 35 - Delete Custom Scenario Dialog Box

2. Select the scenario from the pull down and click OK.

Power Reports

The power report enables you to quickly determine if any power consumption problems exist in your design.
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To generate a power report:

1. From the Designer Tools menu, choose Reports > Power > Power. The Power Report dialog box appears.

2. Select the options you want to include in the report, and then click OK. The power report appears in a separate

window.

You can also generate the power report from within SmartPower. From the Tools menu, choose Reports > Power Report, or click
the Report button to open the Report dialog box. By default, the report includes global design information and a power summary.

Specify which results you want to display by selecting the categories and their options.

The power report dialog box is organized in the following panels: General, Operating Conditions, Options,

Breakdown by Instance, Frequency Summary, and Probability Summary.

General
The general panel enables you to select what to include in the report, the report format, and the mode that you want to

generate the report for.

Power, Report ['5_(|

Select Categon: |

B General
@ Operating Conditions Inziude in the report Ii
B Dptions

A8 Breakdown by instance
eﬁ Frequency summary
Q[}- Frobability surnmany

Pawer summary

Break.down by rail

Break down by type
Breakdown by clock domain
Thermal zurnmary

B atteru lite

Clock domain summary
Operating condition surmrmary -

OOoO0OOOO®™

Repart Format: |Text j

Mode: |.ﬁ.ctive j 1]

Help 0. | Cancel |

Figure 36 - SmartPower Power Report Dialog Box - General Panel

Include in the Report

Select the option(s) that you want to include in the Power Report:
Power summary — This section reports the static, dynamic and total power consumption of the design.
Breakdown by rail — This section shows the power consumption of each rail.

Breakdown by type — This section enables reporting on the power consumption according to: gates, nets, clocks, core

static, IOs and memories.
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Breakdown by clock domain — This section enables reporting on the power consumption of each clock domain.

Thermal summary — This section includes a thermal report. The ambient temperature can be defined by the operating

conditions or defined by the ambient temperature.
When the first option is selected, the following characteristics are reported:
e Operating conditions
e Temperature range
¢ Junction temperature
When the second option is selected, the following characteristics are reported:
e Ambient temperature
o Cooling style
e Package
e Thermal resistance Theta-JA
¢ Junction temperature
e Temperature range
¢ Junction temperature range limits specification
Battery Life — This section reports the battery life.
Clock Domain Summary — This section reports the clock and data frequencies for each clock domain.
Operating Condition Summary — This section reports the operating conditions.

Annotation Coverage - This section reports the number and percentage of pins annotated by each source (VCD,
manual annotation, SmartTime constraint, vectorless estimation, and fixed values) for all clocks, register outputs,

combinational outputs, set/reset nets, primary inputs, enable pins, and other pins

Report Format
Select Text or CSV (Comma Separated Value) as the desired export format.

Mode

Select a mode to generate the report for.

Operating Conditions

The Operating Conditions panel enables you to select the operating conditions for the current report.
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Power, Report

B General

@ Operating Conditions
B Dptions

A8 Breakdown by instance
Ity Frequency summary
Q[}- Frobability surnmany

Help

Select a Category: Operating Conditions

X]
|

Case:  |Typical

Cancel

o]

Figure 37 - SmartPower Power Report Dialog Box - Operating Conditions Panel

Options

The Options panel enables you to select power and frequency units and to use toggle rates.

Power Report

B General
@ Operating Conditions

ﬁ Breakdown by instance
ity Frequency summary
E[}. Probability surrmany

Help

__ &5

itz
Pawer: T
Frequency: MHz -

v Usze toggle rates

Cancel

o |

Figure 38 -

SmartPower Power Report Dialog Box - Options Panel
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Units
Frequency: Sets unit preferences for frequency - Hz, KHz, MHz.

Power Units: Sets unit preferences for power - W, mW, or uW.

Use Toggle Rates

When toggle rates are active (Use Toggle Rates box is checked), the data frequency of all the clock domains is defined
as a function of the clock frequency. This updates the data frequency automatically when you update the clock
frequency. Toggle rates enable you to specify the data frequency as a percentage of clock frequency, but you can no
longer specify the data frequency as a number, only as a percentage of the clock frequency. To set the data frequency

again, clear the Use Toggle Rates option.

Breakdown by Instance

From this panel you can include the breakdown by instance in the report and set specific options.
Power Report E'

Select a Category: Breakdown by inst

B General
@ Operating Conditions

B Options : Iv Include breakdown by instance
ﬁ Breakdown by instance
Ity Frequency summary [ Limit the number of reported instances to

Probability surmmar
E[}. v i [ Report only instances with power greater than Tt

Sork by |PDWE‘:I’ Yalues j

Sort order: |Descending j

Help Qg | Cancel

Figure 39 - SmartPower Power Report Dialog Box - Breakdown By Instance Panel

Include breakdown by instance — This section shows the power consumption of each element that has been

instantiated in the design: gates, nets, memories, and IOs.
The breakdown by instance can be filtered by:
e Limit the number of reported instances to: will limit the number of instances reported to the specified number.

¢ Report only instances with power greater than: any instance with power consumption below the selected value

will not be reported.

This section can be sorted by selecting the preferred method:
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e Sort by: Name (alphabetical) or Power Values
e Sort Order: Ascending or Descending

Note: Note: The filter reduces the number of lines in the report, one per instance.

Frequency Summary

From this panel you can include the frequency summary in the report and set specific options.

Power Report

B General
@ Operating Conditions

__ &5

B Options ) [v Include frequency summary
ﬁ Breakdown by instance
ity Frequency summary [ Limit the number of reported pins bo

Probability surmmar
E[}. v i [ Report only pins with frequencies greater than MHz

Sork by |Frequency ﬂ

Sort order: |Descending j

Help Qg | Cancel

Figure 40 - SmartPower Power Report Dialog Box - Frequency Summary Panel

Include frequency summary — This section shows the frequency summary and reports the pin, net, domain, frequency,

and frequency source for each pin.
The frequency summary can be filtered by:
¢ Limit the number of reported pins to: will limit the number of pins reported to the specified number.

¢ Report only pins with frequencies greater than: any pin with a frequency below the selected value will not be

reported.
This section can be sorted by selecting the preferred method:
e Sortby: Pin Name, Net Name, Domain, Frequency, or Source

e Sort Order: Ascending or Descending

Probability Summary

From this panel you can include the probability summary in the report and set specific options.
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Power, Report E'

Select a Category: Probability summary |

B General

&) Operating Conditions

4@ Dpticns ] [v Include probability summarsy
A Breakdown by ingtance

eﬁ Frequency summary

Q[}. Probability zummary Sort by |F‘in Name ﬂ

Sork order: |Descending ﬂ

Help 0. | Cancel

Figure 41 - SmartPower Power Report Dialog Box - Probability Summary Panel
Include probability summary — This section shows the probability summary and reports the driver, net, rate, source,

and type for each pin.
This section can be sorted by selecting the preferred method:
e Sortby: Pin Name, Net Name, Rate, Source, or Type

e Sort Order: Ascending or Descending
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F fpga_igloo - Power Report

File  Actions

Help

Power Report for design fpgs igloo with the following sSettings:

Vendor : Letel Corporation

Program: Letel Designer Software, Releasse 5.4, Copyright

Date: Thu May 29 13:39:57 2005

Version: 3.0

Design: fpga igloo

Family: IGLOO

Die: AGLAOOVE

Package: 4534 FBGA

Temperature Range: COM

Voltage Range: COM

Operating Conditcions: Typical

Operating Mode: Aotive

Data Source: Advanced

Fower Suroary

e Fm————————— o +

| | Power (W) | Percentage |
e Fm————————— o +

| Total Power | 21.733 | 100.0% |

| SBtatic Power | 0.15¢8 | 0.7% |

| Dynamic Power | 21.577 | 99.3% |

B et B e B +

Ereakdown by Instance

- - - - +
| | Type | Power (wll) | Macro
- - - - +
| n445 | Net | 4,110 |

| U444 | IS0 | 0.635 | ADLIE:CLEEBUF
| U5sZ | I/o | 0.6358 | ADLIB:CLEBUF
| n453 | MNet | 0,447 |

| U535 | I/0 | 0.325 | ADLIE:INEUF
| LMDotIEyteltrLd | Net | 0.300 |

| PL/n & | Net | 0.275 |

| Uioo | IS0 | 0.209 | ADLIE:OUTEUF
| U101 | IS0 | 0.2Z09 | ADLIE:OUTEUF
| U104 | IS0 | 0.2Z09 | ADLIE:OUTEUF
| U105 | I/o | 0.209 | ADLIE:OUTEBUF
| Tio0a | I/o | 0,.z20% | ADLIE:OQUTEBUF
£

)

19859-2008

Figure 42 - SmartPower Report

In addition to the information selected on the Power Reports dialog box, the report contains global design information.

Global design information: This section shows the target family, the package and the die. It also shows information

about the operating conditions, speed grade, and power mode. This option is set by default.
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See Also
Report (Power)

Scenario Power Report

The scenario power report enables you to select a previously defined scenario and calculate the average power

consumption and the battery life for this scenario.

To generate a scenario power report:

Note: Note: In order to generate a scenario power report, your design must contain one or more scenarios.

1. From the Designer Tools menu, choose Reports > Power > Power Scenario. The Scenario Power Report dialog

box appears.

2. Select the options you want to include in the report, and then click OK. The scenario power report appears in a

separate window.

You can also generate the scenario power report from within SmartPower. From the Tools menu, choose Reports >
Scenario Power Report, or click the Scenario Power Report button to open the Power Scenarios dialog box. By default,
the report includes global design information and power sequencer summary. Specify which results you want to display

by checking the boxes to be included in the report.

The power report dialog box is organized in the following panels: General, Operating Conditions, Options, and

Battery Life.

General
The general panel enables you to select what to include in the report, the report format, and the scenario you want to

generate the report for.
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Scenario Power Report f'5__<|
|
B General
&2 Operating Conditions Inciude in the report
B Options i Breakdown by rail
& Battem life Breakdown by bype

Breakdown by mode
Operating candition summary

Report famat: | Text j

Scenarnio; | soenariod -

Help 0k | Cancel |

Figure 43 - SmartPower Scenario Power Report Dialog Box — General Panel

Include in the Report

Breakdown by Rail — This section shows the power consumption of each rail.
Breakdown by Type — This section enables reporting on the power consumption according to: gates, nets, clocks, core
static, IOs, and memories.

Breakdown by Mode — This section enables reporting on the power consumption by mode.

Operating Condition Summary — This section reports the operating conditions.

Report Format
Select Text or CSV (Comma Separated Value) as the desired export format.

Scenario

Select a previously defined scenario to generate the report from.

Operating Conditions

The Operating Conditions panel enables you to select the operating conditions case for the current design.
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Scenario Power Repori

Select a Category: Operating Conditions
B Genera

ls Eatteny life

Scenario Power Report

X

Case:

Help

Twpical

o]

Cancel

Figure 44 - SmartPower Scenario Power Report Dialog Box — Operating Conditions Panel

Options

The Options panel enables you to select power and frequency units and to use toggle rates.

Scenario Power Report

B General

@ O perating Conditions
] |:||,i|:| ns

[ Eattery life

Unitz
Power:

Frequency:

Help

[v Usze toggle rates

3
|

i

-

MHz

-

o]

Cancel

Figure 45 -

SmartPower Scenario Power Report Dialog Box — Options Panel
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Units
Frequency: Sets unit preferences for frequency — Hz, KHz, MHz.

Power Units: Sets unit preferences for power — W, mW, or oW.

Use Toggle Rates

When toggle rates are active (Use Toggle Rates box is checked), the data frequency of all the clock domains is defined
as a function of the clock frequency. This updates the data frequency automatically when you update the clock
frequency. Toggle rates enable you to specify the data frequency as a percentage of clock frequency, but you can no
longer specify the data frequency as a number, only as a percentage of the clock frequency. To set the data frequency

again, clear the Use Toggle Rates option.

Battery Life

The Battery Life panel enables reporting of the battery capacity and the battery life. Enter a battery capacity in
MA/Hrs.

Scenario Power Report f5_<|

Select a Category: Battery life |

B General
@ Operating Conditions
B Options

B attery life

[v Include battery life

Eaktery capaciby: | 1000,00 ma * Hrs

Help ak | Cancel

Figure 46 - SmartPower Scenario Power Report Dialog Box — Battery Life Panel

The SmartPower scenario power report returns the average power consumption and battery life for this sequence.
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Fa fpga_igloo - Power_scenario Report E|@|g|

File Actions Help
~
Joenario  Power Report for design fpga igloo with the following settings:
Vendor : Actel Corporation
Program: Letel Designer S3oftware, Release §.4, Copyright (C) 1989-20038
Date: Thu May 29 13:42:10 20085
Version: 3.0
Design: fpga igloo
Family: IGLOO
Die: AGLAOOVE
Package: 454 FEGL
Temperature Range: COM
Voltage Range: COM
Operating Conditcions: Typical
Data Source: Advanced
Scenario Mame: my Scenario
Jeenario Average Power
B et B e B +
| | Power (W) | Percentage |
e Fm————————— o +
| Total Power | 10.928 | 100.0% |
| SBtatic Power | 0.138 | 1.3% |
| Dynamic Power | 10.788 | 95.7% |
- - - +
Battery Life
e o +
| Battery Capacity | 1000.000 mi*Hours |
- - +
| Batterv Life | 207.803 Hours |
- - +
EBreakdown by mode
- e e i +
| Mode | Power in the Mode (wW) | Duration | Power*Duration Weight |
- - - - +
| Mode Active | 21.733 | 50.0% | 99.5% |
| Mode Static | 0.156 | 35.0% | 0.5% |
| Mode Sleep | 0.033 | 15.0% | 0.0% |
e e e e e e +
w
< »

Figure 47 - SmartPower Scenario Power Report
In addition to the information selected on the Scenario Power Reports dialog box, the report contains global design

information, a mode summary and the sequence average power.
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Global design information: This section shows the target family, the package and the die. It also shows information

about the operating conditions, speed grade and power mode. This option is set by default.
Power Summary: This section reports the power consumption of the sequence by mode. This option is set by default.

Sequence Average Power: This section reports the average power consumption of the sequence. This option is set by

default.

See Also

Report (Sequencer)

Cycle-Accurate Power Reports

Traditional power analysis based on a VCD simulation file reports an average power for the entire simulation time.
Based on a VCD simulation file, the cycle-accurate power analysis will report one power value per clock period (or half-
period) instead of an average power for the whole simulation. This feature allows to easily identify the worst cycle in
terms of power performance; and helps to understand and further minimize power consumption by facilitating the
analysis of data-dependent power variations, as well as dynamic power variations due to clock-gating, or even clock

frequency variations.

To generate a cycle-accurate power report:
1. From the Designer Tools menu, choose Reports > Power > Power Cycle Accurate. The Cycle Accurate Power

Report dialog box appears.

2. Select the options you want to include in the report, and then click OK. The cycle accurate power report appears

in a separate window.

You can also generate the cycle accurate power report from within SmartPower. From the Tools menu, choose Reports
> Cycle Accurate Power Report to open the cycle accurate power report dialog box; or select a ved file from the Modes
and Scenarios toolbar, and from the right-click menu, select Tools > Power Cycle Accurate.

The cycle-accurate power report dialog box is organized in the following panels: General, Sampling Period, Partial

Parsing, Top-Level Name, Glitch Filtering, and History Size Reduction.
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General

Cycle Accurate Power, Report

General

Sampling period

WCD parzing options
?2::1“?&'5;[:';?1& WD File: | O warklcode design_wved'BMakor, wed j EI
(litzh Filkering

Higtaory size reduction

3
|

Report Format: Text -

Use operating condikions From: |.ﬁ.ctive j i

Help ak

Figure 48 - SmartPower Cycle Accurate Power Report Dialog Box — General
VCD file - Select the VCD file you want to import.

Cancel

Report format — Select Text or CSV (Comma Separated Value) as the desired export format.

Use operating conditions from — Select the mode from which the operating conditions will be used
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Sampling Period

Cycle Accurate Power, Report

Select a Category: Sampling period

General

_ 5

Sampling period
WCD parzing options

: ) f*  Automatic detection fram clocks Pui_clk. -
Partial parzing =

T':_'p IE?EI rjame * Compute an average value per clock period
(litzh Filkering

Higtaory size reduction (" Compute an average value per half clock period

" Specify:

T
—

Help ak | Cancel |

Figure 49 - SmartPower Cycle Accurate Power Report Dialog Box — Sampling Period
Automatic detection from clock — This option automatically detects the sampling period from the fastest clock. You
can also select any other clock in your design. You can specify whether the average value is computed per period or

half-period.

Specify — Select this option to specify the period and offset used to calculate the sampling period.
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Partial Parsing

Cycle Accurate Power, Report

Select a Category: Partial parsing

General

Sampling period

WCD parzing options
Partial parzing

qu |E\f'E| name v Partially parse D
Glitch filtering

3
|

Higtaory size reduction

Stark time: 0.00 ns

End time: 10000,00 ns

Help [ o ]

Cancel

Figure 50 - SmartPower Cycle Accurate Power Report Dialog Box — Partial Parsing

Partially parse VCD file — Specify the Start and End times to partially parse the VCD file. This option can be used for
large VCD files.

Top-Level Name

Cycle Accurate Power, Report

Select a Category: Top level name

General

Sampling period

WCD parzing options
Partial parzing

_ 5

Top level name
(litzh Filkering
Higtaory size reduction

* automatic detection

" Specify:

Cancel

Help [ o ]

Figure 51 - SmartPower Cycle Accurate Power Report Dialog Box — Top-Level Name
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This option enables you to select how the top-level name is specified. Select Automatic Detection to let the

VCD reader automatically detect the top-level name of the design, or select Specify to manually specify the top-level
name.

Glitch Filtering

Cycle Accurate Power, Report

Select a Category: Glitch filtering

General

Sampling period

WCD parzing options
Partial parzing
Top level name

_ 5

. Ifilitu::'u fiItEerir'ug ~ off
Hiztary size reductian

* automatic glicch filkering

(™ Specify filkering threshaold:

Help [ o ]

Cancel

Figure 52 - SmartPower Cycle Accurate Power Report Advanced Options Dialog Box — Glitch Filtering
This panel enables you to filter out pulses of short durations by selecting Automatic Glitch Filtering or by entering a
value in the Specify Filtering Threshold field. The default glitch filtering option is Automatic Glitch Filtering.
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History Size Reduction

Cycle Accurate Power, Report

General

Sampling period

WCD parzing options
Partial parzing
Top level name
(litzh Filkering

Higtaory size reduction

3
|

v Keep only local extrema

[ Set power threshold:

Help [ o ]

Cancel

Figure 53 - SmartPower Cycle Accurate Power Report Advanced Options Dialog Box — History Size Reduction
This panel enables you to limit the history size by keeping only local extrema or setting a power threshold.

The results are displayed in the cycle accurate power report below.
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] simple_ PWM_8 - Power_cycle accurate Report

File Actions Help

VActel

Aotel Corporation - Aotel Designer Software Release 5.4

Copyright (o) 1989-2Z0058
Date: Thu May 29 13:53:58 2008

Design : simple PWHM 8

Family : IGLOO

Die : AGLEOOVE

Package : 256 FBGL
Tetperature Rahnge @ COM
Voltage Rance : COM

Operating Conditions : Typical
Operating Mode : Static

Data J3ource : Advanced

Ved File: Difwork/code/design_wved/BHotor.wved

Max Fower Report

- Fm———————— +
| Cyole | Start Time |
- - +
| 21 | ZOoooooo |
- - +

- Fm———————— F—————————
| Cyole | Start Time | End Time (ps)
- - -
|1 | O | 100000

| 2 | 100000 | ZOo0oooo

| 11 | 1000000 | 1100000

| 13 | 1ZOo0oo0 | 1300000

| 16 | 1500000 | 1600000

| 17 | 1e00000 | 1700000

| 18 | 1700000 | 1800000

| 21 | ZOoooooo | 2100000

| 22 | Ziooooo | Zz0ooooo

| 23 | ZZOooooo | 2300000

| z4 | Z300000 | Z400000

| 25 | Z400000 | ZE500000

| 26 | 2500000 | 2600000

| z9 | Zg0ooooo | 2900000

| 30 | 2200000 | 3000000

| 31 | 3000000 | 3100000

| 32 | 3100000 | 3200000

£

+ =+ =+

+— +

——————————— +
Power (il

oo oo oo oo oo o oo oo o0

(Wersion &.4.0.0)

Activity and Hazards Reports

Traditional Power Analysis based on a VCD simulation file reports an average power value that will account for all nets

Figure 54 - SmartPower Cycle Accurate Power Report

switching in the design. This switching includes functional transitions and spurious transitions. Due to the delay of

each gate, paths arriving at one internal gate may have different propagation delays. Therefore, a gate may exhibit
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multiple spurious transitions before settling to the correct logic level. The Activity and Hazards Power Report allows to
quickly identify gates and nets of the design that consume power because of spurious transitions. This is helpful to
understand and further minimize power consumption. The activity and hazards report reads a VCD file and reports

transitions and hazards for each clock cycle of the VCD file.

To generate an activity and hazards power report:
1. From the Designer Tools menu, choose Reports > Power > Power Activity and Hazards. The Activity and
Hazards Power Report dialog box appears.

2. Select the options you want to include in the report, and then click OK. The activity and hazards report appears

in a separate window.

You can also generate the activity and hazards report from within SmartPower. From the Tools menu, choose Reports
> Activity and Hazards Report; or select a ved file from the Modes and Scenarios toolbar, and from the right-click

menu, select Tools > Power Activity and Hazards

The activity and hazards report dialog box is organized in the following panels: General, Partial Parsing, Top-Level

Name, Glitch Filtering, and Clock Domains.

General
Activity And Hazards Power Report [5__(|
Select a Categary: |
General
WD parging ophions WD File: | Dyworkicodedesign_ved\BMakor wed j III
Fartial parzing
Top level name Report Format: | Text -
Glitch filtering
Clock domaing Use operating condikions from: |.ﬁ.ctive ﬂ (i ]

Repaort bype:  |Repart by Met - summary ﬂ

For each net, report activity and power;

sort by bokal power; sort order descending;
Lirnit the number of reported nets to 40,

Help 0k Cancel

Figure 55 - SmartPower Activity and Hazards Report Dialog Box — General
VCD file - Select the VCD file you want to import.

Report format — Select Text or CSV (Comma Separated Value) as the desired export format.
Use operating conditions from — Select the mode from which the operating conditions will be used.

Report type — Select the report type:
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e Report by net — summary: summary report by net
e Report by net — detailed: detailed report by cycle
e Report by cycle — summary: summary report by net

e Report by cycle — detailed: detailed report by cycle

VActel

The selected report type reports activity and power for each net sorted by power in descending order and limits the

number of reported nets to 20 by default. To change these options, click each option and from the pop-up menu,

select the desired option:

e Report: Select the query report type: activity, power, or activity and power.

o Sort by: Select the query sort by functional power, functional transitions, spurious power, spurious transitions, or

total power.
e Sort order: Select the query sort order: ascending or descending.

e Limit the number of reported nets: Enter the query filter limit.

Partial Parsing

Activity And Hazards Power Report

Select a Category: Partial parsing

General

WCD parzing options
Partial parzing
Top level name

Glitch fiIFering v Partially parse YD
Clock domains

Stark time: 0.00 ns

End time: 10000.00 ns

Help ak | Cancel

_ =5

Figure 56 - SmartPower Activity and Hazards Report Dialog Box — Partial Parsing

Partially parse VCD file — Specify the Start and End times to partially parse the VCD file. This option can be used for

large VCD files.
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Top-Level Name

Activity And Hazards Power, Report

Select a Category: Top level name

General

3
|

YLD parzing options
Fartial parsing

Top level name
[litzh filkering
Clock domains

* automatic detection

" Specify:

Help [ o ]

Cancel

Figure 57 - SmartPower Activity and Hazards Report Dialog Box — Top-Level Name
This option enables you to select how the top-level name is specified. Select Automatic Detection to let the

VCD reader automatically detect the top-level name of the design, or select Specify to manually specify the top-level
name.
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Glitch Filtering

Activity And Hazards Power, Report

Select a Category: Glitch filtering

General
YLD parzing options
Fartial parsing

__ &9

Clock domaing ~ off
{* automatic glitch filkering

™ specify filkering threshaold:

Help ak | Cancel

Figure 58 - SmartPower Activity and Hazards Report Advanced Options Dialog Box — Glitch Filtering
This option enables you to filter out pulses of short durations by selecting Automatic Glitch Filtering or by entering a

value in the Specify Filtering Threshold field. The default glitch filtering option is Automatic Glitch Filtering.

Activity And Hazards Power, Report

Select a Category: Clock domains
Clock domain

Clock Domains
E3
|

General

YLD parzing options
P . d |:| {+ Autormatic construction
Fartial parsing
Top level name £ Specify:

[litzh filkering
Clock domains

Clock domain | Achtive clock | Achive edge

1 Pt _clk true || rising i
2 |unl_dataa_int_ME| trug || rising R

Help ak | Cancel |

Figure 59 - SmartPower Activity and Hazards Report Advanced Options Dialog Box — Clock Domains
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The clock domain can be automatically constructed or it can be specified by the user.

Automatic construction — This option automatically constructs the clock domain. SmartPower automatically analyzes

your design to assess if a clock is active and what is the active edge.
Specify — Select this option to specify the period and first edge.
Use the clock domain table to set the active edge (rising, falling or both) and to set a clock as transparent.

The results are displayed in the activity and hazards power report below.

simple_PWM_B - Power_activity_and_hazards Report

File Actions Help

hctivity map report -

Actel Corporation - Actel Designer Joftware Release §.4 (Version 5.4.0.0)
Copyright (o) 1959-Z005
Date: Tue May 06 10:43:59 Z005

Design : simple PWH S

Family : IGLOO

Die : AGLGOOVE

Package : Z586 FEGAL
Temperature Range : CON
Voltage Range : CON

Operating Conditions : Typical
Operating Mode : Active

Data Jource : Advanced

Vod file: D:/work/code/design wved/BMotor.voed

Aotivicy Map @ Summary

| Transitions | Dynamic Power (mll) |

| Total | 44154 | 0.155 |
| Functional | 32364 | 0.1z8 |
| Spurious | 113zZ0 | O.027 |

Activity Map: Net Swanary

| Net | Clock Domain | Type | Functional | Spurious | Functional | Spurious |
| | | | Transitions | Transitions | Fower | Power |
| | | | | [t [t |
| PWM_clk c | PUM_clk | Clock | 5993 | a | 0.0%0 | 0.000 I
| WM _clk c_0 | PUM_clk | Clock | 5993 | a | 0.019 | 0.000 I
| Qaux[0] | unl_dstaa int NE:Y | Data | 1 | z9886 | 0.000 | 0.013 I
| PWM_clk_pad/U0/NETL | PUM_clk | Clock | 5993 | a | 0.010 | 0.000 I
| Qaux[1] | unl_dstaa int NE:Y | Data | 1 | 1492 | 0.000 | 0.005 I
| un3i_gsux_Ul_DWACT FINC_E[O] | PWM clk | Data | 746 | a | 0.003 | 0.000 I
| Qaux[z] | unl_dstaa int NE:Y | Data | O | 746 | 0.000 | 0.003 I
| Qaux[3] | unl_dstaa int NE:Y | Data | 23 | 350 | 0.000 | 0.002 I
| unl_dstaa_int_0O_i | unl_dstas_int NE:Y | Data | 1 | z9886 | 0.000 | 0.001 I
| I_4 | PUM_clk | Data | 2987 | a | 0.001 | 0.000 I
| I_5 | PUM_clk | Data | 1494 | a | 0.001 | 0.000 I
| PWM_out_pad/U0/NETL | unl_dstaa int NE:Y | Data | 21 | a | 0.001 | 0.000 I
| unl_dstaa int_1_i | unl_dstas_int NE:Y | Data | 1 | 1492 | 0.000 | 0.001 I
| I_8 | PUM_clk | Data | 747 | a | 0.001 | 0.000 I
| Caux[4] | unl_dstaa int NE:Y | Data | 2 | 184 | 0.000 | 0.001 I
| I_13 | PUM_clk | Data | 373 | 374 | 0.000 | 0.000 I
| un3_gsux_N_zz | PUM_clk | Data | 746 | a | 0.000 | 0.000 I
| Qaux[S] | unl_dstaa int NE:Y | Data | 3 | =0 | 0.000 | 0.000 I e
< ¥

Figure 60 - SmartPower Activity and Hazards Report
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Cycle-Accurate Power Analysis

The Cycle-Accurate Power Analysis reports cycle-accurate power data in a graphical form. In the analysis window, you
can specify ranges and compute averages for each range, define a list of watched blocks, obtain power usage of a single

block or cycle, or obtain power usage of multiple blocks over several cycles.

To generate a cycle-accurate power analysis:

1. From the SmartPower Tools menu, choose cycle-accurate Power Analysis; or select a ved file from the Modes
and Scenarios toolbar, and from the right-click menu, select Tools > cycle-accurate Power Analysis. The cycle-
accurate Power Analysis dialog box appears.

2.

Select the options you want to include in the report, and then click OK. The cycle-accurate power report appears

in a separate window.

The cycle-accurate power analysis dialog box is organized in the following panels: General, Sampling Period, Partial
Parsing, Top-Level Name, and Glitch Filtering.

General

Cycle Accurate Power Analysis

General

Sampling period

WCD parzing options
?2::1“?&'5;[:';?1& e}y SR B e For SmarkPowerlvishal Fpu A3P1000,vod IR I
(litzh Filkering

_ 5

Use operating condikions From: Ackive j i

Help ak | Cancel

Figure 61 - SmartPower cycle-accurate Power Analysis Dialog Box — General
VCD file — Select the VCD file you want to import.

Use operating conditions from — Select the mode from which the operating conditions will be used.
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Sampling Period

Cycle Accurate Power Analysis

Select a Category: Sampling period

General

Sampling period

WCD parzing options
Partial parzing
Top level name
(litzh Filkering

f*  Automatic detection fram clocks clk -

* Compute an average value per clock period

(" Compute an average value per half clock period

" Specify:

T
—

Help [ o ]

Cancel |

3
|

Figure 62 - SmartPower cycle-accurate Power Analysis Dialog Box — Sampling Period

Automatic detection from clock — This option automatically detects the sampling period from the fastest clock. You

can also select any other clock in your design. You can specify whether the average value is computed per period or

half-period.

Specify — Select this option to specify the period and offset used to calculate the sampling period.
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Partial Parsing

Cycle Accurate Power Analysis

Select a Category: Partial parsing
General

_ 5

Sampling period

WCD parzing options
Partial parzing
Top level name

N v Partially parse WD
(litzh Filkering

Stark time:

0.00 ns

End time:

10000.00 ns

Help

ak | Cancel

Figure 63 - SmartPower cycle-accurate Power Analysis Dialog Box — Partial Parsing

Partially parse VCD file — Specify the Start and End times to partially parse the VCD file. This option can be used for
large VCD files.

Top-Level Name

Cycle Accurate Power Analysis

Select a Category: Top level name
General

_ 5

Sampling period
WCD parzing options
Partial parzing

Top level name

(litzh Filkering

* automatic detection

" Specify:

Help

ak | Cancel

Figure 64 - SmartPower cycle-accurate Power Analysis Dialog Box — Top-Level Name
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This option enables you to select how the top-level name is specified. Select Automatic Detection to let the

VCD reader automatically detect the top-level name of the design, or select Specify to manually specify the top-level
name.

Glitch Filtering

Cycle Accurate Power Analysis

Select a Category: Glitch filtering
General

Sampling period

WCD parzing options
Partial parzing
Top level name

_ 5

[litzh filkering

" Off

* automatic glicch filkering

(™ Specify filkering threshaold:

Help

OF. | Cancel

Figure 65 - SmartPower cycle-accurate Power Analysis Advanced Options Dialog Box — Glitch Filtering

This option enables you to filter out pulses of short durations by selecting Automatic Glitch Filtering or by entering a
value in the Specify Filtering Threshold field. The default glitch filtering option is Automatic Glitch Filtering.
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Cycle-Accurate Power Analysis Window

ll Cycle Accurate Analysis #1

k|- J—?s f:‘b‘ w'::b ol Add marker Time unit: |cycle number = Go ko cyde: | 18 Go
Analysis block: |Fp|_|_t|3p ﬂ Settings surmmary

fpu_top =

-
om

-
=

- =
o M

power usage (mW)
o

cycles

ks JJ

il =

Select a cycle or a range (horizontal line) ko get power usage

Power
Block (mW)
1 i fpu_top --
z JuT --
3 deb_inst --
WD Files D fworkfcadeffor SmartPower fvishal_Fpu_a3P1000,ved Add remove watched blocks |

Help Close

Figure 66 - cycle-accurate Power Analysis

Mouse over a cycle to obtain the cycle number, the start and end times, and the power usage for the selected cycle.

h

Use the Select button to select a cycle in the analysis, the grid displays the block name and power usage for the
watched blocks.

Us the Add Marker button to create cycle ranges — intervals between markers and/or the simulation ends.
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To select a range, mouse over the average power usage horizontal line. This will display the average power usage for the

range.

To move to the beginning or end of a range, right-click the average power usage of the range and select Go to

Beginning of Range or Go to End of Range.

To move the marker to another cycle, click and drag the marker to another cycle; or from the right-click menu, select

Move marker, and enter a time value.
To delete the marker, right-click the marker, and select Delete marker.

To move to the previous or next markers, right-click the marker, and select Go to previous marker or Go to previous

marker.

D]

Use the | Zoom In button to zoom in the analysis view.

b

Use the | Zoom In Horizontal button to zoom in the analysis view.

4
Us the Zoom Out button to zoom out the analysis view.
[P ] )
Us the Zoom to Full View button to zoom into full view.

To view the most power-consuming blocks for a cycle, right-click the cycle, and select Show Most Consuming Blocks

for this Cycle. This opens the Biggest Power Contributors for Cycle window.
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Biggest power contributors for cycle 8

o e Ry R PV S

Help

Block

fpu_top
JuT
UUTAus/ 110401
UUTAuEATL_ 0
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LT ud
[T

Power
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[

[ €

Close

Figure 67 - Biggest Power Contributors for a Cycle Window

To view the analysis for a specific time, enter a time value in the Go to time box, select the time unit, and press the Go

button.

To view the analysis for a specific block, select the block from the Analysis Block pull-down.

To export the cycle-accurate power analysis chart, right-click the chart, and select Export Chart to File.

You can modify the blocks you want to watch during analysis, by pressing the Add/Remove Watched Blocks button.

If the operating conditions in SmartPower have been modified, a warning appears to indicate that the settings have

been changed. Click the hyperlink to regenerate the Cycle-Accurate analysis view.

Click the View Settings Summary button to display the cycle-accurate settings.
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Cycle-Accurate Power Analysis

]

Setting

Walue

WD file

Operating conditions from mode
Sampling perod
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Figure 68 - Cycle-Accurate Settings Summary
Click the Add/Remove Watched Blocks button to display a list of watched blocks . You can add or remove watched

blocks by checking or unchecking the Watch checkbox for that particular block(s) or by selecting blocks in the grid and

using the Check or Uncheck Selected Blocks buttons. You can use the filter options to hide or display the list of blocks

based on the criteria entered.
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Figure 69 - Watched Blocks

Importing a VCD File
The Value Change Dump (VCD) file is a simulation file. The format of this file is specified in the IEEE 1364

standard.

You can configure the Project Manager to automatically generate VCD files using ModelSizn.
You can also generate a VCD file with a ModelSim simulator using the following commands:

ved file example.vcd

vced add -r /testbench/<top>_0/*
run 1 us

ved Flush

This example creates a VCD file example.ved, adds all signals recursively, runs the simulation for one micro second,

and quits. You must quit ModelSi in order to get an accurate result from SmartPower.

If you have not yet completed the layout of the design, the design software guides you through place-and-route so that
you can import the VCD file. In order to successfully annotate your VCD values to the design, Designer must

complete place-and-route even if you generated your VCD file using timing simulation (pre-layout).
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Note: Note: SmartPower has been validated with VCD files generated by ModelSiz. However, you may use any
Verilog/VHDL simulator that offers a VCD dump feature.

Refer to the user manual of your simulation tool for more information on how to generate a VCD file.

To import a VCD file:
1. From the Simulation menu, select Import VCD File. This opens the Import VCD Options dialog box.

Import ¥CD Options b—q

General |

Select a Category:

General
YLD parging options
Partial parzing
Top level name
Glitch filtering WD File: |D:'|,wu:urk'l,cu:ude'l,sub.vcd ﬂ

R emaining signals

Importt in:

{* Existing mode: |.Cl.ctive ﬂ

" New mode: |

Help Qg | Cancel

Figure 70 - Import VCD File Dialog Box

2. Select the VCD file you want to import and select a mode to import it in, or click New Mode and enter a mode

name.
3. Select the options you want to specify:

Partial Parsing — Specify the Start and End Times to partially parse the VCD file. This option can be used for large VCD files.
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Import ¥CD Options E'
Select a Category: Partial parsing |
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| Partially parse YD

Help 0. | Cancel

Figure 71 - Import VCD File Dialog Box — Partial Parsing
Top-Level Name — This option enables you to select how the top-level name is specified. The Top Level Name is the instance

name of your design instantiated in the simulation testbench.

Select Automatic Detection to let the VCD reader automatically detect the top-level name of the design, or select Specify to
manually specify the top-level name.

Import YCD Options E'
Select a Category: Top level name |
General

YLD parging options
Partial parzing

T op level name
Glitzh filkering
R emaining signals

¥ aukomatic detection

" Specify:

Help Qg | Cancel

Figure 72 - Import VCD File Dialog Box — Top-Level Name
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Glitch Filtering — This option enables you to filter out pulses of short durations by selecting Automatic Glitch Filtering or by
entering a value in the Specify Filtering Threshold field. The default option is Automatic Glitch Filtering.

Import ¥CD Options E'
Select a Category: Glitch filtering |
General

WD parzing options
Fartial parzing
Top level name

Glitch filtering
Femaining signals

O Off

{*  Aukomatic glikch Filkering

" Specify Filkering threshold: |

Help 0. | Cancel

Figure 73 - Import VCD File Dialog Box — Glitch Filtering

Remaining Signals — Some signals may not be annotated by the VCD reader. This generally happens with VCD files created
from a behavioral or a post-synthesis simulation. For those signals, you can either complete the annotation with the vectorless

analysis or with the average values computed from the VCD file.

Import YCD Options E'
Select a Category: Remaining signals |
General

YLD parging options
Partial parzing
Top level name
Glitzh filkering

R emaining signals

¥ se Yectorless analysis

(" IUse &verage values computed from YCD

Help Qg | Cancel

Figure 74 - Import VCD File Dialog Box — Remaining Signals
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4. Click OK.

5. When the ved file is successfully imported, the file appears in the Modes and Scenarios toolbar, under the
imported mode. The following messages appear in the Designer Log window:
Info:
VCD:34 glitch(es) filtered with 1000 ps threshold
The message above reports the number of glitches that have been filtered by the VCD reader.

Info:

VCD: Annotation Statistics

Percentage of Annotated Pins:100.00 %

Percentage of Unannotated Pins:0.00 %

Percentage of Annotated Pins with Zero Frequency: 25.99 %

If the percentage of annotated pins is less than 50.00%, a warning message will be generated.

If the percentage of annotated pins is low, you may want to verify that signals at all levels of hierarchy were added

recursively (for example using ved add —r in ModelSim).

If you simulate a pre-synthesis netlist or a post-synthesis RTL netlist, it is possible to get a low percentage of
annotated pins. This happens because not all logic elements are in the pre-synthesis netlist and the post-synthesis

RTL netlist. For accurate power estimation, it is best to run post-layout simulation with a back-annotated netlist.

If you want to see exactly which pins are not annotated, open the SmartPower Frequencies tab. If your file was
imported successfully, you will see a list of pins with annotated individual frequencies displayed with VCD Import as
a source. The unannotated pins are displayed with Default Estimation as source. If your design has enable pins,

open the SmartPower Probabilities tab.

After finishing the import VCD process, you can now create a custom mode based on the active mode. This custom
mode will inherit all the clock and toggle frequencies of the active mode that have just been set through the VCD
import. This final step is optional. It gives you the flexibility to modify the active mode frequencies while saving the

VCD scenario in SmartPower. Refer to_Custom operating modes for more details.

Note: Note: If you generated the VCD file from Project Manager and if you are using Designer from Libero IDE,
the list of generated VCD files appear in the unprocessed VCD file list. To import the VCD file, right-click
and select Import VCD File.
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Figure 75 - Unprocessed Simulation Files

Importing a SAIF File in Designer

Use the following instructions to import a SAIF file.

To import a SAIF file:
1. From the File menu in Designer, select Import Auxiliary Files. Click Add to browse to your SAIF file and select
it. When you have selected a SAIF file, click OK to continue.

If you have not yet completed the layout of the design, the design software guides you through place-and-route
so that you can import the SAIF file. In order to successfully annotate your SAIF values to the design, Designer
must complete place-and-route even if you generated your SAIF file using timing simulation (post-layout).

You may wish to import multiple SAIF files. If these files conflict (attempt to set a different frequency for the

same net of your design, for example), the latest imported value takes precedence.

2. Specify your SAIF import options. Use the SAIF Import Options window to specify the instance name of your
design in the simulation testbench (the instance name is the instance name of your design instantiated in the
simulation testbench). Y ou must include the hierarchy with the instance name. The example below shows how
to identify the instance name of your design in the SAIF file. For example, the instance name of the design in

the following SAIF file is “TEST_BENCH/UUT”.

(SAIFILE

(SAIFVERSION "1.1'")

(DESIGN 2FF)

(DATE “Fri May 10 14:48:46 2002')

(TIMESCALE 1ns)

(DURATION 50000)

(INSTANCE TEST_BENCH/UUT (PORT (OUT_PORT (TC 26) (IG 0) (T1
25994)

(TO 22000) (TX 2006))))

(INSTANCE TEST_BENCH/UUT/\outpad/U0/U1\ (PORT (Y (TC 26) (IG 0)
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(T1 25995) (TO 22000) (TX 2005))))

(INSTANCE TEST_BENCH/UUT/\FF1/UO\ (PORT (Q (TC 27) (IG 0) (T1
26000)

(TO 22997) (TX 1003))))

(INSTANCE TEST_BENCH/UUT/\clkpad/U0O/UO\ (PORT (Y (TC 99) (IG 0)
(T1 25000) (TO 24999) (TX 1))))

Click OK to continue.

3. Check the Log window for notification that you successfully imported the SAIF file (“The Import command
succeeded...”). Even if the Import command succeeds, Actel recommends that you use SmartPower to verify

which pins have been affected after you import the file.
4. Verify results of the imported file in the Frequencies tab screen in SmartPower. To view the results of your
imported SAIF file, launch SmartPower and navigate to the Frequencies tab screen to view pins with annotated

switching activities. If your file was imported successfully, you will see a list of pins with annotated switching

frequencies and specific individual frequencies.

It may be that some pins of your design are not annotated by a SAIF import command. This sometimes happens if you simulate a
pre-synthesis netlist. It is normal; not all logic elements are in the pre-synthesis netlist. Thus it is better to do a post-layout

simulation with a back-annotated netlist for the most accurate power estimation.

Removing a VCD File
The Value Change Dump (VCD) file is a simulation file. The format of this file is specified in the IEEE 1364

standard.

To remove a VCD file:
e Select the VCD file from Active mode or a custom mode, right-click the VCD file, and select Remove VCD

File from <mode name> Mode; or
e From the Simulation menu, choose Remove VCD File > <file name>
Note: Note: Any annotation will be removed when you remove the VCD file.

See Also
Importing a VCD File

Modes and Scenarios Toolbar

Auditing Files

SmartPower checks the time stamps of the VCD file and reports any missing or out-of-date files.
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Audit is performed automatically when SmartPower is launched. You can trigger file audit at any time from the
Simulation menu, by choosing Audit Files. An icon displaying the file status appears in the Modes and Scenarios

toolbar next to the VCD file. Mouse over the icon to obtain more information.

Modes and scenarios x
todes

Achive

AN testZved

Flazh*Freeze

Sleep

Static

new_cuztom

9 test.ved

SCenanos

Figure 76 - Audit Files Results
Table 4 - Audit Files Icons and Descriptions

Icon Description
& Indicates that the VCD file has been modified
e Indicates that the VCD file is missing

To re-import the VCD file, right-click the VCD file and select Re-import VCD File, this will open the Import VCD
Options dialog box.
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Steps to Calculate Power
Use the steps below to calculate the power consumption of your design. The list of screens and steps appear in the order

in which you should view them to analyze your power accurately.
1. Summary tab — View global power at the design level and view its impact on junction temperature.
2. Domains tab — Define clock domains and specify a clock frequency and a data frequency for each clock domain.

3. Analysis tab — View detailed hierarchical analysis of your power consumption. This step is optional. But if your

power consumption exceeds your budget, this step will help you to understand where there is room for

improvement.
4. Frequencies tab — Specify individual pin frequencies, this step is optional, but gives you pin-by-pin control of the
frequency.

5. Probabilities tab — Specify probabilities, this step is optional. You can use the default probabilities or set your

own.

Extracting Power Consumption of a Specific Clock Domain

To calculate the power consumption of a single clock domain (clock tree and data path) in a
design:

1. Set SmartPower in toggle-rate mode. This is the default setting. To confirm that SmartPower is in toggle-rate

mode, choose Preferences from File menu. Select the Use Toggle Rates check box
2. In the Domains tab, set all the Clock Frequencies to zero except for the clock domain for which you are
calculating the power consumption.
The total power consumption of this clock domain is displayed in the Summary tab. This includes the contribution of
the clock buffer, clock tree, and all clock input of the registers of this specific clock domain.

Note: Note: In case you need to determine the power of the clock tree only, set the toggle rate of data on that clock

domain to zero. The total power displayed is the power of that clock tree.

Advanced Analysis of 1/0s

SmartPower provides an easy way of estimating the power consumption related to I/Os. You can then analyze power

consumption in detail.

To display I/0O power consumption:
1. In the Summary tab, select By Type from the Breakdown drop-down list. The grid displays the total power

consumption of all I/Os in the design, as well as all other components. If you use different I/0 standards, and
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different Veci power rails, you can also display the power consumption for each rail by selecting By Rail from the
Breakdown drop-down list. Breakdown By Rail shows the power consumption and current for each Veci rail in

the design.

2. In the Analysis tab, select the highest hierarchy level in the Hierarchy tree in the left pane. Select By Instance

from the Breakdown drop-down list.

3. In the Analysis tab, unselect all categories under Instances Contributions except 1/Os, and then click Apply.
The table then displays a list of all I/Os in the design, along with the power contribution of each individual I/O.
The columns display important I/O attributes: external port name, load, standard, drive-strength, slew, and

macro.

4. In the Probabilities tab, you can control the output probability of each tri-state and bidirectional I/O. The
probability is the percentage of time that the I/O is used as an output. The default value can be changed and a

specific value can also be set for each bidirectional or tri-state I/O.

See Also
Analyze results

Analysis tab

Define Clock Domains and Set of Pins

When you run SmartPower, it researches your existing clock domains and partitions your design automatically. You
may wish to review the list of clock domains in the Domains tab to ensure that all the clocks of your design are

included in the list. Add or remove clocks as necessary.

To add a new clock domain:
1. Click the Domains tab, and click the Add Domain button. Select Clock Domain from the drop-down list. This
opens the Create Clock Domain dialog box.

Create Clock Domain

Creat
Potential Clock Pin [N =3

Clock Frequency I 10 MHz
[ ata Frequency I 1 tHz

Figure 77 - Create Clock Domain Dialog Box — Toggle Rates Disabled

di

Cancel

2. To create a new clock, select a Potential Clock Pin, specify a clock and data frequency, and click Create. The
new clock domain appears in the Domains window. If you select an existing clock pin from the drop-down list,

the lists of clock pins and data pins of this new clock domain are computed automatically based on the netlist

topology.
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Note: Select Use Toggle Rates in the SmartPower Preferences to define your data frequency as a percentage of
your clock frequency. If your data frequency is 20% of your clock frequency, type "20" in the Data Frequency text

box.

Create Clock Domain

Cieat
Patertial Clock Pin SRR ks

Clack Frequemncy I 10 MHz
Data Frequency I 20 X

Figure 78 - Create Clock Domain Dialog Box — Toggle Rates Enabled

Cancel

di

You may wish to create an empty clock domain and fill the lists of clock-pins and data pins manually. If so, do not

select a clock pin, just type a new name for your clock domain.

Beyond the verification of the list of clock domains, you may also wish to verify that the lists of clock pins and data pins

computed for each clock domain are correct.

To verify the lists of clock pins and data pins of a clock domain:

1. Click the Domains tab and select a specific Domain in the list.

2. Display the list of clock pins or data pins of this Domain. A drop-down list in the Domains tab enables you to
select clock pins or data pins. SmartPower displays the list of pins corresponding to your selection below the

drop-down list. You can add or remove clock pins and data pins as necessary.

3. Remove a pin from a clock domain. Highlight the selected pin and click the Remove button. The pin is removed

from the clock domain and is made available in the list of pins that you can add in another clock domain.
4. Highlight the selected pin in the list of pins that are not yet in a domain and click the Add button to add a pin in

a clock domain. This pin is added to the clock domain. It is a clock pin or a data pin, depending on the

specification of the drop-down list when you click the Add button.

Note: Note: You cannot add a pin that exists in another domain until you free it from its existing domain. The pin is

unavailable until you remove it from that domain.

After you have verified that all the clocks of your designs are correctly identified and constructed, you must specify the
correct clock and data frequency for each clock domain.

To add a new set of pins:

1. Open the Create Clock Domain dialog box. Click the Domains tab, and click the Add Domain button. Select
Set of Pins from the drop-down list.
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Figure 79 - Create Set of Pins Dialog Box
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2. Create a Set of Pins. Name your new set of pins, specify a data frequency, and click Create. The new set of pins

appears in the Domains window.

Specify Clock and Data Frequencies in SmartPower

To specify a clock and data frequency:
1. Click the Domains tab

2. select the Clock/Data frequency cell and type in a new value

SmartPower defaults to 0 MHz for the clock frequency. Import your clock frequency from SmartTime by using the

Initialize Frequencies dialog box in SmartPower or input your target for each clock frequency in the Domains

tab. You must also specify a data frequency (5% of your clock frequency is a typical guideline for your data frequency —

this corresponds to a toggle rate of 10 %.)

Not all the pins/gates/nets of your design are associated with a specific clock. For example, the frequency of a design
input port is not always correlated to a clock frequency. By extension, all pins that are upstream of the first level of
sequential elements are not associated with any clock. SmartPower creates an InputSet by default that it uses to group
all the pins that are controlled by design inputs (instead of sequential elements). You may wish to view and verify the
InputSet to further evaluate your design.

Viewing and Verifying the InputSet in SmartPower
To verify the InputSet:

1. Click the Domains tab and select the domain named InputSet in the list.

2. Verify the list of pins of this domain. All the input ports of your design (except the clocks) belong in the
InputSet. Also, all the pins that are between these input ports and the first level of sequential elements belong in
the InputSet. You can add or remove pins as necessary.

3. Specify an average input frequency. SmartPower uses the same frequency for all pins of the InputSet. The default
InputSet frequency is 1 MHz. Type in a new value to change it.

You may wish to split the InputSet into several sets in order to specify different frequencies. A classic example is to

create a ResetSet, a reset tree with a very low frequency.
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To split the InputSet into several sets:
1. Create a new set of pins: In the Domains tab, click the New button, and select Set of Pins from the drop-down
menu. In the Create Set Of Pins dialog box, type a name and a frequency for the new set and click Create. The
new set of pins appears in the Domains window. You can only create an empty set of pins, but it is possible to

add pins to this domain later.

2. Remove a group of pins from the InputSet. Click the Domains tab and select the domain named InputSet in the

list. Select the pins that you want to remove and click the Remove button.

3. Add this group of pins to the new set of pins. Click the Domains tab and select the newly created set of pins in
the list. Highlight the pins in the list of pins that are not yet in a domain, and click the Add button. Repeat these

three steps as necessary to create multiple input sets.

Specifying Individual Pin Frequencies

The Frequencies tab enables you to specify an average clock and data frequency for each clock domain, and also an
average frequency for each set of pins. This gives you an initial estimate of the power consumption of your design.

However, if this estimate is not accurate enough, you may refine it with a pin-by-pin annotation of the frequency.

To specify a frequency annotation for an individual pin:
1. Locate the pin in the Frequencies tab. You may need to select different clock domains from the drop-down list

on the Frequencies tab. You can use filters to facilitate this search.

2. Select the pin(s) in the grid and click the Set frequencies for selected pins button, enter a new frequency value,

and click OK. This specifies a new frequency for the selected pin(s).

Note: Note: This annotation procedure enables you to set the frequency of an individual pin, but this does not mean
that the pin is removed from its clock domain. A frequency annotation just overrides the domain level

frequency.

You may wish to change or remove a frequency annotation of an individual pin. This may be useful when you import a

VCD (value change-dump) file or a SAIF (Switching Activity Interchange Format) file.

To change the frequency annotation of an individual pin:
1. Locate the pin in the Frequencies tab. You may need to select different clock domains from the drop-down list

on the Frequencies tab. You can use filters to facilitate the search.

2. Select the pin(s) in the grid and click the Set frequency for selected pins button, enter a new frequency value, and

click OK. This specifies a new frequency for the selected pin(s).

To remove the frequency annotation of an individual pin:
1. Locate the pin in the Frequencies tab. You may need to select different clock domains from the drop-down

menu on the Frequencies tab. You can use filters to facilitate the search.

2. Select the pin(s) in the grid and click the Reset frequencies for selected pins button. This removes the specified

frequency from the selected pins.
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The Probabilities tab enables you to specify the default output probability value for memory blocks, and tristate and
bidirectional I/Os. In addition, you can increase the accuracy of the power estimation by annotating the probability of
specific pins.
To specify or change the probability for one or multiple pins:

1. Locate the pin(s) in the Probabilities tab. You can use filters to facilitate this search.

2. Select the pin(s) and press the Set probabilities for selected pins button.

3. Enter a new probability value and press OK.
To reset the probability for one or multiple pins:

1. Locate the pin(s) in the Probabilities tab. You can use filters to facilitate this search.

2. Select the pin(s) and press the Reset Probabilities for selected pins button. This will reset the probability value.

Vectorless Estimation

The Vectorless estimation method is an accurate method of annotating individual pins with frequencies and
probabilities. It uses primary inputs, clock frequencies, and nets annotated with other methods as a starting point, and
uses a Monte Carlo simulation to annotate all nets in the design with frequencies and probabilities.

Vectorless estimation is available and enabled by default for IGLOO, ProASIC3, SmartFusion and Fusion families of

devices.

Vectorless estimation can be enabled from the Initialize Frequencies and Probabilities dialog box or from the VCD
Import dialog box.

Changes to probabilities or frequencies in the Probabilities, Frequencies, or Domains tabs result in an out-of-date

o
vectorless estimation. To update vectorless estimation, press the refresh vectorless ™  button.

Viewing Results (Design Level)
Click the Summary tab to view global power consumption at the design level. The Summary tab shows your design's

estimated power consumption and temperature information.

The power estimation reported in the Summary tab is the total static and dynamic power consumption of your design.

For a more detailed view of this power consumption, click the Analysis tab.

To estimate the junction temperature:
1. Verify your package. You cannot change your package directly in SmartPower, because it may render your place-
and-route information (and thus it may severely impact the total power consumption). If you wish to choose

another package, you have to do it in Designer > Tools > Device Selection.
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Analyzing Results

2. Click the Summary tab, and select a Cooling style in the list. Thermal resistance changes automatically when you

update the cooling style.

3. Specify an ambient temperature. Enter an ambient temperature (default value is 25°C), and click the Set button.

Note: The junction temperature value changes according to the package, cooling style, and ambient temperature

values you choose.

The Analysis tab displays the estimated power consumption of individual blocks, gates, nets, I/Os, and memory and

enables you to make a hierarchical analysis of your power consumption. The Analysis tab may also help you to improve

your power consumption by identifying the components that consume a significant amount of power.

To identify the components consuming the most power:

1. Use the Analysis tab to expand the design hierarchy. The Analysis tab enables you to expand your design

hierarchy and view a complete list of the blocks in your design. In the hierarchy window, click the + next to your

design to view the items in the hierarchy. Click the + next to a sub-block to view its sub-elements.
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Figure 80 - Analysis Tab Dialog Box

2. Click to select a block. By default, SmartPower selects the design-level block, but you can always select another

block in the hierarchical tree. The Report window displays the list of sub-elements of the selected block.
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Initially, this list includes all sub-elements. The grid in the Analysis window displays a breakdown of the power
of the selected block by type. This breakdown provides you a good overview of which areas of your design you

should optimize for power.

To find the components that use a significant amount of power, choose By Instance from the Breakdown drop-

down list.

Sort and filter the sub-elements to find the component that is using the most power. The Analysis window
displays the list of sub-elements of the selected block. By default, this list includes all sub-elements. The grid
contains columns for name, type, power, driver, fanout, macro, I/O standard, output load, output drive, slew,
port, domain and frequency. You may limit the list of sub-elements to a list of sub-blocks, nets, gates, I/Os,
memories, or any combination of these five classes of sub-elements. You can sort the list according to any

column by double-clicking the column header.

See Also

Advanced Analysis of I/Os

Analysis tab

Cross-Probing in SmartPower

SmartPower supports cross probing with the other Designer tools. You must calculate your design's power

consumption before you can cross probe effectively. See the Calculating Power section for more information.

To cross probe with the SmartPower tool:

1.

DA

View the detailed results of your power analysis in the Analysis tab of the SmartPower tool.
Select By Instance from the Breakdown drop-down list.

Open MultiView Navigator in Designer.

Select your component.

Click a sub-component in the grid to highlight the corresponding component in the ChipPlanner or PinEditor

tool.
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Figure 81

- Cross-Probing with SmartPower: SmartPower Analysis View
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Figure 82 - Cross-Probing with SmartPower: ChipPlanner View

SmartPower Calculation Equations
SmartPower calculates the static power and the dynamic power of your design, for given operating conditions and
operating modes:
Static Power: This value is a summation of the static power consumed by each element of the design. SmartPower
provides a static power consumption of the array. This value is die-dependent. This value is also a function of the
operating mode. For some families, SmartPower also considers a static power contribution per I/O bank. For specific
1/0 technologies like voltage referenced 1/Os or differential I/Os, SmartPower also considers a static power

contribution per I/0.

Dynamic Power: This value is a summation of the dynamic power consumed by each element of the design (nets,

modules, I/Os, RAMs, FIFOs, PLLs, etc.).
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Operating Conditions: SmartPower calculates power consumption in Worst, Typical, or Best operating conditions.

SmartPower uses the following as general guidelines:

o Itapplies a voltage derating to dynamic power contributions. Higher voltage typically leads to higher power

consumption.

o Itapplies a temperature derating to static power contributions. Higher temperature typically leads to higher

power consumption.
e Itapplies no radiation derating.

Operating Modes: SmartPower calculates power consumption in Active, Static, Flash*Freeze, Sleep, and Shutdown

operating modes, when applicable for your design.

Sample Equations:
The examples below are for general evaluation purposes only. They are not a precise representation of the actual

calculations, since each calculation takes into account family-specific information.

e For anet,
P=C- V2. F
where C is the total capacitive loading of the net (extracted from the routing topology), V is the net's voltage

swing, and F is the average switching frequency.

Note: Note: For the ProASICELS family, SmartPower extracts the capacitive loading of a net from a Wire Load

model.

e For a module, the power is computed using a characterized library (by family and die-size) describing a specific
power model for each type of module. For example, the power model of a flip-flop is given by
P R = ] I ] R &
r=1 CK ! K +1 Dour f DGL-"T+ f Din ! Din
where Fcx is the average clock-input frequency for this flip-flop, Fpour is its average data-output frequency, and

Pck, Poour, poin are three constants estimated by electrical simulation and silicon characterization for this flip-

flop module, and FDin is its average data-input frequency.

e For an I/0, the formula used for computing the power consumption depends on the I/O technology and the
family. For example, for a TTL output, the dynamic power is given by
P=Pyp F+C- 12 F
where C is the output load (derived from what you have set in the 1/O Attribute Editor GUI, typically 35 pF for
TTL), V is the output's voltage swing (3.3 V for TTL), and PinT represents an internal power contribution

dissipated in the pad, and F is the average switching frequency of the I/O.
e For a complex block, like 2 RAM, a FIFO, or a PLL, SmartPower uses a high-level power model that integrates

design parameters.
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SmartPower automatically computes all the constant parameters of these equations. However, the frequencies depend
on the target frequencies of your design. Since it is impractical to enter each frequency manually, SmartPower has

several flows that help you to estimate the frequencies and calculate the power consumption.
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SmartPower Tcl Commands

SmartPower supports the following Tel scripting commands:

report (Activity and Hazards Power Report)

report (Cvcle Accurate Power Report)

Report (Data History)

report (Power)
Report (Power Scenario)
smartpower add new custom mode

smartpower add new scenario

smartpower add pin in domain
smartpower change clock statistics
smartpower change setofpin statistics

smartpower commit

smartpower create_domain
smartpower_edit custom mode

smartpower edit scenario

smartpower initialize clock with constraints

smartpower init do

smartpower init set clocks options

smartpower init set combinational options

smartpower init set enables options

smartpower init set othersets options

smartpower init set primaryinputs options

smartpower init set registers options

smartpower init set set reset options
smartpower init setofpins values

smartpower remove all annotations

smartpower remove custom mode

smartpower remove dornain

smartpower remove_file
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e smartpower remove pin enable rate

o smartpower remove pin frequencv

e smartpower remove pin of domain

e smartpower remove pin probability

o smartpower remove_scenario

o smartpower remove ved

o smartpower restore
° smartpower set battegy capacigy

o smartpower set cooling

e smartpower set mode for analysis

e smartpower set operating condition

e smartpower set pin probability

o smartpower set pin frequencv

o smartpower set preferences

e smartpower set scenario for analysis

e smartpower set temperature opcond
e smartpower set thermalmode

e smartpower set voltage opcond

e smartpower temperature opcond set design wide

e smartpower temperature opcond set mode specific

e smartpower voltage opcond set design wide
e smartpower voltage opcond set mode specific

report (Activity and Hazards Power Report)

The activity and hazards report reads a VCD file and reports transitions and hazards for each clock cycle of the
VCD file.

report -type power_activity _map \
[-vcd_file {path}] \

[-style {value}] \

[-partial_parse {value}] \

[-start_time {value}] \

[-end_time {value}] \
[-auto_detect_top_level name {value}] \
[-top_level_name {name}] \
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[-report_type {value}] \
[-report_query {value}] \
[-sortby {value }] \
[-sortorder {value }] \
[-max_net {value}] \
[-max_cycle {value}] \
[-clock_settings {value}] \
[-glitch_filtering {value}] \
[-glitch_threshold {value}] \
[-auto_construct_clock domain {value}] \
[-clock period {value}] \
[-clock_offset {value}] \
[-opmode {value}] \

{filename}
Arguments
type -power_activity_map
Specifies the type of report to generate is an activity and hazards power report.
-vcd_file {path}
Specifies the path to the *.ved file that you want to import.
-style {value}
Specifies the format in which the report will be exported. The following table shows the acceptable values for this
argument:
Value Description
Text The report will be exported as Text file
CSvV The report will be exported as CSV file
-partial_parse {value}
Specifies whether to partially parse the *.ved file. The following table shows the acceptable values for this argument:
Value Description
true Partially parses the *.ved file
false Does not partially parse the *.ved file

-start_time {value}

This option is available only if ~partial ly_parse is set to true. Specifies the start time (in ns) to partially parse
the *.vcd file.

-end_time {value}

This option is available only if -partial ly_parse is set to true. Specifies the end time (in ns) to partially parse
the *.ved file.

-auto_detect_top_level_name {value}
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Specifies whether to automatically detect the top-level name. The following table shows the acceptable values for
this argument:

Value Description
true Automatically detects the top-level name
false Does not automatically detect the top-level name

-top_level_name {name}
Specifies the top-level name.
-report_type {value}
Specifies the report query type. The following table shows the acceptable values for this argument:

Value Description
activity Includes activity information for each net
power Includes power information for each net
activity and power Includes activity and power information for each net

-report_query {value}

Specifies the report type. The following table shows the acceptable values for this argument:

Value Description
Report by Net - summary Provides a summary report for each net
Report by Net - detailed Provides a detailed report for each net
Report by Cycle - summary Provides a summary report for each cycle
Report by cycle - detailed Provides a detailed report for each cycle

-sorthy {value}

Specifies how to sort the values in the report. The following table shows the acceptable values for this argument:

Value Description
total power Sorts based on the power values
spurious power Sorts based on the spurious power
functional power Sorts based on the functional power
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Value Description
spurious transitions Sorts based on the spurious transitions
functional transitions Sorts based on the functional transitions

-sortorder {value}

Specifies the sort order of the values in the report. This could be descending or ascending.

-max_net {value}

Specifies the maximum number of nets to report. In a net summary or net details report, this argument limits the
total number of entries. In a cycle details report, this argument limits the number of nets reported for each cycle.
-max_cycle {value}

Specifies the maximum number of cycles to report. In a cycle summary or cycle details report, this argument limits
the total number of entries. In a net details report, this argument limits the number of cycles reported for each net
-clock_settings {value}

Specifies the settings for the clock. The format is "< clock name >:< active edge { value } >". The
following table shows the acceptable values for the active edge:

Value Description
rising Sets the clock to a rising active edge
falling Sets the clock to a falling active edge
both Sets the clock to both rising and falling active edge
not_active Does not use the signal as a clock

-glitch_filtering {value}
Specifies whether to use glitch filtering. The following table shows the acceptable values for this argument:

Value Description

true Glitch filtering is on

auto Enables automatic glitch filtering. This option will ignore

any value specified in -glitch_threshold

false Glitch filtering is off

-glitch_threshold {value}
This option is only available when —glitch_filtering is set to true. Specifies the glitch filtering value in ps.
-auto_construct_clock_domain {value}
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Specifies whether to automatically construct the clock domain. The following table shows the acceptable values for
this argument:

Value Description

true

Automatically constructs the clock domain

false

Does not automatically construct the clock domain

-clock_period {value}

Use this option to specify a virtual clock period (in ps). This should be used if ~auto_construct_clock_domain
is set to False.

-clock_offset {value}

Use this option to specify the time of the first active edge of the virtual clock (in ps). This should be used if —
auto_construct_clock_domain is set to false

-opmode {value}

Use this option to specify the mode from which the operating conditions are extracted to generate the report.
{filename}

Specifies the name of the report.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

Exceptions

Examples

e None

e None

This example generates an activity and hazards power report named report_power_activity_map.xt.

report -type "‘power_activity_map" -vcd_file "D:/FPU/mul.vcd” -style "Text" -
partial_parse "TRUE" -start_time "0.05" -end_time "1.00" -auto_detect_top_level_name
"TRUE" -report_query "Report by Net - Summary" -clock_settings
"UUT/un3_out_3:Y:not_active" -clock_settings "clk:rising" -glitch_filtering "FALSE" -
glitch_threshold 100" -auto_construct_virtual_clock "TRUE" -virtual_clock_period
'*10000.00" -virtual_clock_first_edge "0.00" -opmode "Active'\
{D:/FPU/report_power_activity map.txt}

report (Cycle Accurate Power Report)

Creates a cycle accurate power report, which reports a power waveform with one power value per clock period or

half-period instead of an average power for the whole simulation.
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report -type power_peak_analyzer \
[-vcd_file {path}] \

[-style {value}] \

[-partial_parse {value}] \

[-start_time {value}] \

[-end_time {value}] \
[-auto_detect_top_level _name {value}] \
[-top_level _name {name}] \
[-glitch_Ffiltering {value}] \
[-glitch_threshold {value}] \
[-auto_detect_sampling_period {value}] \
[-sampling_clock { }]1 \
[-sampling_rate_per_period {value}] \
[-sampling_offset {value}] \
[-sampling_period {value}] \
[-use_only_local_extrema {value}] \
[-use_power_threshold {value}] \
[-power_threshold {value}] \

[-opmode {value}] \

{filename}
Arguments
-type power_peak_analyzer
Specifies the type of report to generate is a cycle accurate power report.
-vcd_file {path}
Specifies the path to the *.ved file that you want to import.
-style {value}
Specifies the format in which the report will be exported. The following table shows the acceptable values for this
argument:
Value Description
Text The report will be exported as Text file
CSv The report will be exported as CSV file
-partial_parse {value}
Specifies whether to partially parse the *.ved file. The following table shows the acceptable values for this argument:
Value Description
true Partially parses the *.ved file
false Does not partially parse the *.ved file

-start_time {value}

This option is available only if -partial ly_parse is set to true. Specifies the start time (in ns) to partially parse
the *.ved file.
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-end_time {value}

This option is available only if -partial ly_parse is set to true. Specifies the end time (in ns) to partially parse
the *.ved file.

-auto_detect_top_level_name {value}

Specifies whether to automatically detect the top-level name. The following table shows the acceptable values for
this argument:

Value

Description

true

Automatically detects the top-level name

false

Does not automatically detect the top-level name

-top_level_name {name}

Specifies the top-level name.

-glitch_filtering {value}

Specifies whether to use glitch filtering. The following table shows the acceptable values for this argument:

Value

Description

true

Glitch filtering is on

auto

Enables automatic glitch filtering. This option will ignore any

value specified in -glitch_threshold

false

Glitch filtering is off

-glitch_threshold {value}

This option is only available when -glitch_filtering is set to true. Specifies the glitch filtering value (in ps).

-power_summary {value}

Specifies whether to include the power summary, which shows the static and dynamic values in the report. The
following table shows the acceptable values for this argument:

Value

Description

true

Includes the power summary in the report

false

Does not include the power summary in the report

-auto_detect_sampling_period {value}

Specifies whether to automatically detect the sampling period. The following table shows the acceptable values for
this argument:

Value

Description

true

Automatically detects the sampling period
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Value Description

false

Does not automatically detect the sampling period

-sampling_clock {}
Specifies the sampling clock.
-sampling_rate_per_period {value}

Specifies whether to set the sampling rate per period. The following table shows the acceptable values for this
argument:

Value Description

true

Specifies the sampling rate per period

false

Specifies the sampling rate per half period

-sampling_offset {value}
Specifies the offset used to calculate the sampling offset (in ps).
-sampling_period {value}
Specifies the offset used to calculate the sampling period (in ps).
-use_only_local_extrema {value}

Specifies whether to limit the history size by keeping only local extrema. The following table shows the acceptable
values for this argument:

Value Description

true

Limits the history size by keeping only local extrema

false

Does not limit the history size by keeping only local extrema

-use_power_threshold {value}

Specifies whether to limit the history size by setting a power threshold. The following table shows the acceptable
values for this argument:

Value Description

true

Limits the history size by setting a power threshold

false

Does not limit the history size by setting a power threshold

-power_threshold {value}

Sets the power threshold value.

-opmode {value}

Use this option to specify the mode from which the operating conditions are extracted to generate the report.
{filename}
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Specifies the name of the report.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example generates a cycle accurate power report named report_power_cycle_based. txt.

report -type "‘power_cycle_based" -vcd_file "D:/FPU/mul _.vcd" -style "Text" -partial_parse
"TRUE" -start_time "0.05" -end_time "1.00" -auto_detect_top_level_name "TRUE" -
glitch_filtering "FALSE"™ -glitch_threshold "100" -auto_detect_sampling_period "TRUE" -
sampling_clock "clk" -sampling_rate_per_period "TRUE" -sampling_offset "0.00" -
sampling_period "10000.00" -use_only_local_extrema "TRUE" -use_power_threshold "TRUE" -
power_threshold ""0.00" -opmode "Active™ \ {D:/FPU/report_power_cycle_based.txt}

report (Data Change History)

Creates a Data Change History report, which lists new features and enhancements, bug fixes and known issues for
the current release that may impact the power consumption of the design.

report -type power_history \
{report.txt}

Arguments
-type power_history
Specifies the type of report to generate is a data change history report.
{report.txt}

Specifies the name of the report. You must use .txt as the filename extension.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None

Exceptions

e None
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Examples

This example generates a data change history report named report. txz.

report -type "‘power_history" \
{report_txt}

report (Power)

Creates a Power report, which enables you to determine if you have any power consumption problems in your
design. It includes information about the global device and SmartPower preferences selection, and hierarchical detail
(including gates, blocks, and nets), with a block-by-block, gate-by-gate, and net-by-net power summary SmartPower

results.

report -type power \
[-powerunit {value}] \
[-frequnit {value}] \

[-opcond {value}] \

[-opmode {value}] \

[-toggle {value}] \
[-power_summary {value}] \
[-rail_breakdown{value}] \
[-type_breakdown{ value}] \
[-clock _breakdown{value}] \
[-thermal_summary {value}] \
[-battery_life {value}] \
[-opcond_summary {value}] \
[-clock_summary {value}] \
[-style {value}] \

[-sortorder {value}] \

[-sortby {value}] \
[-instance_breakdown {value}] \
[-power_threshold {value}] \
[-Filter_instance {value}] \
[-min_power {number}] \
[-max_instance {integer >= 0}] \
[-activity sortorder {value}] \
[-activity_sortby {value}] \
[-activity_summary {value}] \
[-frequency_threshold {value}] \
[-Filter_pin {value}] \
[-min_frequency {value}] \
[-max_pin {value}] \
[-enablerates_sortorder {value}] \
[-enablerates_sortby {value}] \
[-enablerates_summary {value}] \
[-with_annotation_coverage {value}] \
{filename}

Arguments
-type power
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Specifies the type of report to generate is a Power report.
-powerunit {value}

Specifies the unit in which power is set. The following table shows the acceptable values for this argument:

Value Description
W The power unit is set to watts
mW The power unit is set to milliwatts
uW The power unit is set to microwatts

-frequnit {value}

Specifies the unit in which frequency is set. The following table shows the acceptable values for this argument:

Value Description
Hz The frequency unit is set to hertz
kHz The frequency unit is set to kilohertz
MHz The frequency unit is set to megahertz

-opcond {value}

Specifies the operating condition. The following table shows the acceptable values for this argument:

Value Description
worst The operating condition is set to worst case
typical The operating condition is set to typical case
best The operating condition is set to best case

-opmode {value}

Specifies the operating mode. The following table shows the acceptable values for this argument:

Value Description
active The operating mode is set to active
static The operating mode is set to static
sleep The operating mode is set to sleep

SmartPower v9.1 User’s Guide 111



‘ SmartPower Tcl Commands

Value Description
Flash*Freeze The operating mode is set to Flash*Freeze
shutdown The operating mode is set to shutdown

-toggle {value}

Specifies the toggle. The following table shows the acceptable values for this argument:

Value Description
true The toggle is set to true
false The toggle is set to false
-power_summary {value}
Specifies whether to include the power summary, which shows the static and dynamic values in the report. The
following table shows the acceptable values for this argument:
Value Description
true Includes the power summary in the report
false Does not include the power summary in the report
-rail_breakdown {value}
Specifies whether to include the breakdown by rail summary in the report. The following table shows the acceptable
values for this argument:
Value Description
true Includes the breakdown by rail summary in the report
false Does not include the breakdown by rail summary in the report
-type_breakdown {value}
Specifies whether to include the breakdown by type summary in the report. The following table shows the acceptable
values for this argument:
Value Description
true Includes the breakdown by type summary in the report
false Does not include the breakdown by type summary in the report
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-clock_breakdown {value}

Specifies whether to include the breakdown by clock domain in the report. The following table shows the acceptable
values for this argument:

Value Description
true Includes the breakdown by clock domain summary in the report
false Does not include the breakdown by clock domain summary in
the report

-thermal_summary {value}

Specifies whether to include the thermal summary in the report. The following table shows the acceptable values for
this argument:

Value Description
true Includes the thermal summary in the report
false Does not include the thermal summary in the report

-battery_life {value}

Specifies whether to include the battery life summary in the report. The following table shows the acceptable values
for this argument:

Value Description
true Includes the battery life summary in the report
false Does not include the battery life summary in the report

-opcond_summary {value}

Specifies whether to include the operating conditions summary in the report. The following table shows the
acceptable values for this argument:

Value Description
true Includes the operating conditions summary in the report
false Does not include the operating conditions summary in the
report

-clock_summary {value}

Specifies whether to include the clock domains summary in the report. The following table shows the acceptable
values for this argument:

SmartPower v9.1 User’s Guide 113



‘ SmartPower Tcl Commands

Value Description
true Includes the clock summary in the report
false Does not include the clock summary in the report

-style {value}

Specifies the format in which the report will be exported. The following table shows the acceptable values for this

argument:
Value Description
Text The report will be exported as Text file
Csv The report will be exported as CSV file

-sorthy {value}

Specifies how to sort the values in the report. The following table shows the acceptable values for this argument:

Value Description
power values Sorts based on the power values
alphabetical Sorts in an alphabetical order

-sortorder {value}

Specifies the sort order of the values in the report. The following table shows the acceptable values for this argument:

Value Description
ascending Sorts the values in ascending order
descending Sorts the values in descending order

-instance_breakdown {value}

Specifies whether to include the breakdown by instance in the report. The following table shows the acceptable

values for this argument:

Value Description
true Includes the breakdown by instance in the report
false Does not include the breakdown by instance in the report

-power_threshold {value}
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This specifies whether to include only the instances that consume power above a certain minimum value. When this
command is set to true, the -min_power argument must also be used to specify that only the instances that consume
power above this minimum power value are the ones that are included in the report. The following table shows the
acceptable values for this argument:

Value Description
true Includes the power threshold in the report
false Does not include the power threshold in the report

-filter_instance {value}

This specifies whether to have a limit on the number of instances to include in the Power report. When this
command is set to true, the —-max_instance argument must also be used to specify the maximum number of
instances to be included into the Power report. The following table shows the acceptable values for this argument:

Value Description
true Indicates that you want to have a limit on the number of
instances to include in the Power report
false Indicates that you do not want to have a limit on the number of

instances to include in the Power report

-min_power {number}

Specifies which block to expand based on the minimum power value of a block.
-max_instance {integer >= 0}

Sets the maximum number of instances to a specified integer greater than or equal to O (zero). This will limit the
maximum number of instances to be included in the Power report.

-activity_sortorder {value}

Specifies the sort order for the activity summary. The following table shows the acceptable values for this argument:

Value Description
ascending Sorts the values in ascending order
descending Sorts the values in descending order

-activity_sortby {value}

Specifies how to sort the values for the activity summary. The following table shows the acceptable values for this

argument:

Value

Description

pin name

Sorts based on the pin name
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Value Description
net name Sorts based on thepnet name
domain Sorts based on the clock domain
frequency Sorts based on the clock frequency
source Sorts based on the clock frequency source

-activity_summary {value}

Specifies whether to include the activity summary in the report. The following table shows the acceptable values for
this argument:

Value Description
true Includes the activity summary in the report
false Does not include the activity summary in the report

-frequency_threshold {value}
Specifies whether to add a frequency threshold. The following table shows the acceptable values for this argument:

Value Description
true Adds a frequency threshold
false Does not add a frequency threshold

-filter_pin {value}
Specifies whether to filter by maximum number of pins. The following table shows the acceptable values for this

argument:
Value Description
true Filters by maximum number of pins
false Des not filter by maximum number of pins

-min_frequency {value}

Sets the minimum frequency to {decimal value [unit { Hz | KHz | MHz}]}.
-max_pin {value}

Sets the maximum number of pins.

-enablerates_sortorder {value}
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Specifies the sort order for the probabilities summary. The following table shows the acceptable values for this

argument:
Value Description
ascending Sorts the values in ascending order
descending Sorts the values in descending order

-enablerates_sortby {value}

Specifies how to sort the values for the probabilities summary. The following table shows the acceptable values for
this argument:

Value Description
pin name Sorts based on the pin name
net name Sorts based on the net name
domain Sorts based on the clock domain
frequency Sorts based on the clock frequency
source Sorts based on the clock frequency source

-enablerates_summary {value}

Specifies whether to include the probabilities summary in the report. The following table shows the acceptable values
for this argument:

Value Description
true Includes the activity summary in the report
false Does not include the activity summary in the report

-with_annotation_coverage {value}

Specifies whether to include the annotation coverage summary in the report. The following table shows the
acceptable values for this argument:

Value Description
true Includes the annotation coverage summary in the report
false Does not include the annotation coverage summary in the report

{filename}
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Specifies the name of the report.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes
e The following arguments have been removed. Running the script will trigger a warning message: Warning:
Invalid argument: -argname "argvalue" Ignored. Ignore the warning.
-annotated_pins {value}
-stat_pow {value}
-dyn_pow {value}
o Flash*Freeze, Sleep, and Shutdown are available only for certain families and devices.
e Worst and Best are available only for certain families and devices.
Exceptions
e None
Examples

This example generates a Power report named report.rpt.

report -type "‘power’ \
"Power Values™ \
""Descending™ \

"TRUE™ \

"FALSE"™ \

"FALSE"™ \

“Typical™ \
-min_power "2 mW" \
"ACTIVE"™ \

"TRUE"
"TRUE"
"TRUE"
"TRUE"
"5\
"TRUE™ \
{e:\SmartPower\report.rpt}

s 7 7 7

report (Power Scenario)

Creates a scenario power report for a previously defined scenario. It includes information about the global device and
SmartPower preferences selection, and the average power consumption and the excepted battery life for this

sequence.
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report -type power_scenario \

[-powerunit {value}] \
[-frequnit {value}] \
[-opcond {value}] \
[-toggle {value}] \
[-scenario {value}] \
[-style {value}] \
[-battery_life {value}] \

[-battery_capacity {value}] \

[-rail_breakdown {value}]
[-type_breakdown {value}]
[-mode_breakdown {value}]
[-opcond_summary {value}]
{filename}

Arguments

\
\
\
\

-type power_scenario

Specifies the type of report to generate is a scenario power report.

-powerunit {value}

report (Power Scenario)

Specifies the unit in which power is set. The following table shows the acceptable values for this argument:

Value

Description

The power unit is set to watts

mW

The power unit is set to milliwatts

uW

The power unit is set to microwatts

-frequnit {value}

Specifies the unit in which frequency is set. The following table shows the acceptable values for this argument:

Value

Description

Hz

The frequency unit is set to hertz

kHz

The frequency unit is set to kilohertz

MHz

The frequency unit is set to megahertz

-toggle {value}

Specifies the toggle. The following table shows the acceptable values for this argument:

Value

Description

true

The toggle is set to true
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Value Description

false The toggle is set to false

-scenario{value}
Specifies a scenario that the report is generated from.
-style {value}
Specifies the format in which the report will be exported. The following table shows the acceptable values for this

argument:
Value Description
Text The report will be exported as Text file
Csv The report will be exported as CSV file

-battery_life {value}

Specifies whether to include the battery life summary in the report. The following table shows the acceptable values
for this argument:

Value Description
true Includes the battery life summary in the report
false Does not include the battery life summary in the report

-battery_capacity {value}
Specifies the battery capacity in A*H.
-rail_breakdown {value}

Specifies whether to include the breakdown by rail summary in the report. The following table shows the acceptable
values for this argument:

Value Description
true Includes the breakdown by rail summary in the report
false Does not include the breakdown by rail summary in the report.
This is the default value.

-type_breakdown {value}

Specifies whether to include the breakdown by type summary in the report. The following table shows the acceptable
values for this argument:

Value Description
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Value Description
true Includes the breakdown by type summary in the report
false Does not include the breakdown by type summary in the report.

This is the default value.

-mode_breakdown {value}

report (Power Scenario)

Specifies whether to include a breakdown by mode in the report. The following table shows the acceptable values for

this argument:

Value Description
true Includes the breakdown by mode in the report
false Does not include the breakdown by mode in the report. This is

the default value.

-opcond_summary {value}

Specifies whether to include the operating conditions summary in the report. The following table shows the
acceptable values for this argument:

Value Description
true Includes the operating conditions summary in the report
false Does not include the operating conditions summary in the
report

{filename.rpt}
Specifies the name of the report.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e Flash*Freeze, Sleep, and Shutdown are available only for certain families and devices.

e  Worst and Best are available only for certain families and devices.

Exceptions

e None
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Examples

This example generates a scenario power report named report.txt for my_scenario

report -type power_scenario -scenario my_scenario -rail_breakdown true -type breakdown
true -mode_breakdown true -style text -battery_capacity 10 report.txt

See Also
Scenario Power Report

smartpower_add_new_custom_mode

Creates a new custom mode.

smartpower_add_new_custom_mode -name {mode_name} -base_mode {base mode} -description
{mode_description}

Arguments
-name {mode_name}
Specifies the name of the new custom mode.
-base_mode {base_mode}
Specifies the name of the base mode used to create the new custom mode.
-description {mode_description}

Specifies the description of the new custom mode.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example creates a new custom mode "Cust_1" based on the Active mode:

smartpower_add_new_custom_mode -name {Cust_1} -base _mode {Active} -description
{frequency 10 MHz}

See Also
smartpower remove custom mode
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smartpower_add_new_scenario

Creates a new scenario.

smartpower_add_new_scenario

smartpower_add_new_scenario -name {value} -description {value} -mode {value}

Arguments

-name {value}

Specifies the name of the new scenario.

-description {value}

Specifies the description of the new scenario.

-mode {<operating mode>:<duration>}+

Specifies the mode(s) and duration(s) for the specified scenario.

Supported Families

IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example creates a new scenario called myscenario:

smartpower_add_new_scenario -name myscenario -description mynewscenario -mode active:30
+ shutdown:30 + active:40

smartpower_add_pin_in_domain

Adds a pin into a clock or set domain.

smartpower_add_pin_in_domain -pin_name {pin_name} -pin_type {value} —domain_name
{domain_name} -domain_type {value}

Arguments
-pin_name {pin_name}
Specifies the name of the pin to add to the domain.
-pin_type {value}
Specifies the type of the pin to add. The following table shows the acceptable values for this argument:
Value Description
clock The pin to add is a clock pin
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Value Description

data

The pin to add is a data pin

-domain_name {domain_name}
Specifies the name of the domain in which to add the specified pin.
-domain_type {value}

Specifies the type of domain in which to add the specified pin. The following table shows the acceptable values for
this argument:

Value Description

clock The domain is a clock domain

set

The domain is a set domain

Supported Families

Notes

Exceptions

Examples

IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

e The domain_name must be a name of an existing domain.

e The pin_name must be a name of a pin that exists in the design.

e None

The following example adds a clock pin to an existing Clock domain:

smartpower_add_pin_in_domain -pin_name { XCMP3/U0/Ul1:Y } -pin_type {clock} —domain_name
{clkl} -domain_type {clock}

The following example adds a data pin to an existing Set domain:

smartpower_add_pin_in_domain -pin_name {XCMP3/U0/Ul1:Y} -pin_type {data} -domain_name
{myset} -domain_type {set}

See Also

smartpower_remove _pin_of_domain

smartpower_change_clock_statistics

Changes the default frequencies and probabilities for a specific domain.
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smartpower_change_clock_statistics

smartpower_change_clock_statistics -domain_name {value} -clocks_freq {value} -
clocks_proba {value} -registers_freq {value} -registers_proba {value} -set reset_freq
{value} -set_reset_proba {value} -primaryinputs_freq {value} -primaryinputs_proba {value} -
combinational_freq {value} -combinational_proba {value}

Arguments
-domain_name{value}
Specifies the domain name in which to initialize frequencies and probabilities.
-clocks_freq {value}
Specifies the user input frequency in Hz, KHz, or MHz for all clocks.
-clocks_proba {value}
Specifies the user input probability in % for all clocks.
-registers_freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and
toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-registers_proba {value}
Specifies the user input probability in % for all registers.
-set_reset_freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and
toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-set_reset_proba {value}

Specifies the user input probability in % for all set/reset nets.

-primaryinputs_freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and

toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-primaryinputs_proba {value}
Specifies the user input probability in % for all primary inputs.
-combinational_freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and
toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-combinational_proba {value}

Specifies the user input probability in % for all combinational combinational output.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
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Exceptions

e None

Examples

The following example initializes all clocks withs:

smartpower_change_clock_statistics -domain_name {my domain} -clocks_freq {10 MHz} -
clocks_proba {20} -registers_freq {10 MHz} -registers_proba {20} -set_reset_freq {10
MHz} -set_reset_proba {20} -primaryinputs_freq {10 MHz} -primaryinputs_proba {20} -
combinational_freq {10 MHz} -combinational_proba {20}

smartpower_change_setofpin_statistics

Changes the default frequencies and probabilities for a specific set.

smartpower_change_setofpin_statistics -domain_name {value} -data_freq {value} -
data_proba {value}

Arguments
-domain_name{value}
Specifies the domain name in which to initialize data frequencies and probabilities.
-data_freq {value}
Specifies the user input data frequency in Hz, KHz, or MHz for all sets of pins.
-data_proba {value}
Specifies the user input data probability in % for all sets of pins.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all clocks withs:

smartpower_change_setofpin_statistics -domain_name {my_domain} -data_freq {10 MHz} -
data_proba {20}

smartpower_commit
Saves the changes to the design (.adb) file.
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smartpower_create_domain

smartpower_commit

Arguments

e None

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

smartpower_commit

See Also
smartpowe r restore

smartpower_create_domain

Creates a new clock or set domain.
smartpower_create_domain -domain_type {value} -domain_name {domain_name}
Arguments

-domain_type {value}
Specifies the type of domain to create. The following table shows the acceptable values for this argument:

Value Description

clock The domain is a clock domain

set The domain is a set domain

-domain_name {domain_name}

Specifies the name of the new domain.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator
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Notes
e The domain name cannot be the name of an existing domain.
e The domain type must be either clock or set.
Exceptions
e None
Examples

The following example creates a new clock domain named "clk2":

smartpower_create_domain -domain_type {clock} -domain_name {clk2}

The following example creates a new set domain named "myset":

smartpower_create_domain -domain_type {set} -domain_name {myset}

See Also
smartpower_remove_domain

smartpower_edit_custom_mode

Edits a custom mode.

smartpower_edit_custom_mode -name {old_mode_name} new_name {new_mode_name} -description
{mode_description}

Arguments
-name {old_mode_name}
Specifies the name of the custom mode you want to edit.
-new_name {new_mode_name}
Specifies the new name of the custom mode.
-description {mode_description}

Specifies the description of the new custom mode.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None

Exceptions

e None
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smartpower_edit_scenario

Examples

This example edits custom mode "Cust_1" and renames it "Cust_2":

smartpower_edit_custom_mode -name {Cust_1} -new_name {Cust_2} -description {frequency 10
MHz}

See Also
smartpower_remove_custom_mode
smartpower_add_custom_mode

smartpower_edit_scenario

Edits a scenario.

smartpower_edit_scenario -name {value} -description {value} -mode {value} -new_name {value}

Arguments
-name {value}
Specifies the name of the scenario.
-description {value}
Specifies the description of the scenario.
-mode {<operating mode>:<duration>}
Specifies the mode(s) and duration(s) for the specified scenario.
-new_name {value}

Specifies the new name for the scenario

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example edits the name of myscenario to finalscenario:

smartpower_edit_scenario -name myscenario -new_name finalscenario

smartpower_initialize_clock_with_constraints

Initializes the clock frequency and the data frequency of a single clock domain with a specified clock name and the

initialization options.
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smartpower_initialize_clock_with_constraints -clock_name {value}

Arguments
-clock_name {value}
Specifies the name of the clock that will be initialized.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes
e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
e This command is associated with the right-click menu Synchronize Domain with SmartTime on a single clock
domain in the Domains tab.
Exceptions
e None
Examples

The following example initializes "my_clock" with clock constraints from SmartTime:

smartpower_initialize_clock _with_constraints -clock_name {my_clock}

smartpower_init_do

Initializes the frequencies and probabilities for clocks, registers, set/reset nets, primary inputs, combinational outputs,

enables and other sets of pins, and selects a mode for initialization.

smartpower_init_do -with {value} -opmode {value} -clocks {value} -registers {value} -
set_reset {value} -primaryinputs {value} -combinational {value} -enables {value} -othersets

{value}
Arguments
-with{value}
This sets the option of initializing frequencies and probabilities with vectorless analysis or with fixed values. The
following table shows the acceptable values for this argument:
Value Description
vectorless Initializes frequencies and probabilities with vectorless analysis
fixed Initializes frequencies and probabilities with fixed values

-opmode {value}
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smartpower_init_do

Specifies the mode in which to initialize frequencies and probabilities. The mode needs to be based on an Active
mode.

-clocks {value}
This sets the option of initializing frequencies and probabilities for all clocks. The following table shows the

acceptable values for this argument:

Value Description
true Initializes frequencies and probabilities for all clocks
false Does not initialize frequencies and probabilities for all clocks

-registers {value}
This sets the option of initializing frequencies and probabilities for all registers. The following table shows the

acceptable values for this argument:

Value Description
true Initializes frequencies and probabilities for all registers
false Does not initialize frequencies and probabilities for all registers

-set_reset {value}
This sets the option of initializing frequencies and probabilities for all set/reset nets. The following table shows the

acceptable values for this argument:

Value Description
true Initializes frequencies and probabilities for all set/reset nets
false Does not initialize frequencies and probabilities for all set/reset nets
-primaryinputs{value}

This sets the option of initializing frequencies and probabilities for all primary inputs. The following table shows the

acceptable values for this argument:

Value Description
true Initializes frequencies and probabilities for all primary inputs
false Does not initialize frequencies and probabilities for all primary inputs

-combinational {value}
This sets the option of initializing frequencies and probabilities for all combinational outputs. The following table
shows the acceptable values for this argument:
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Value Description
true Initializes frequencies and probabilities for all combinational outputs
false Does not initialize frequencies and probabilities for all combinational
outputs

-enables {value}

This sets the option of initializing frequencies and probabilities for all enable sets of pins. The following table shows
the acceptable values for this argument:

Value Description
true Initializes frequencies and probabilities for all enable sets of pins
false Does not initialize frequencies and probabilities for all enable sets of pins

-othersets {value}

This sets the option of initializing frequencies and probabilities for all other sets of pins. The following table shows
the acceptable values for this argument:

Value Description
true Initializes frequencies and probabilities for all other sets of pins
false Does not initialize frequencies and probabilities for all other sets of pins

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Note: Vectorless estimation is not supported for ProASIC, Proasic®8, and Axcelerator devices.
PP , )

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all clocks with:

132 SmartPower v9.1 User’s Guide



_ VActel

smartpower_init_set_clocks_options

smartpower_init_do -with {vectorless} -opmode {my_mode} -clocks {true} -registers {true}

-asynchronous {true} -primaryinputs {true} -combinational {true} -enables {true} -
othersets {true}

smartpower_init_set_clocks_options

Initializes the clock frequency options of all clock domains.

smartpower_init_set_clocks_options -with_clock constraints {value} -
with_default_values {value} -freq {value} -duty_ cycle {value}

Arguments
-with_clock_constraints {value}

This sets the option of initializing the clock frequencies with frequency constraints from SmartTime. The following
table shows the acceptable values for this argument:

Value Description

true Sets initialize clock frequencies with clock constraints ON

false Sets initialize clock frequencies with clock constraints OFF

-with_default_values {value}

This sets the option of initializing the clock frequencies with a user input default value. The following table shows
the acceptable values for this argument:

Value Description

true Sets initialize clock frequencies with default values ON

false Sets initialize clock frequencies with default values OFF

-freq {value}

Specifies the user input frequency in Hz, KHz, or MHz.
-duty_cycle {value}

Specifies the user input duty cycles in %.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
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Exceptions

e None

Examples

The following example initializes all clocks after executing smartpower_init_do with -clocks {true}:

smartpower_init_set _clocks_options -with_clock_constraints {true} -with_default values
{true} -freq {10 MHz} -duty_cycle {20}

smartpower_init_set_combinational_options

Initializes the frequency and probability of all combinational outputs.

smartpower_init_set_combinational_options -freq {value} -proba {value}

Arguments
-freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and
toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-proba {value}
Specifies the user input probability in %.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all combinational signals after executing smartpower_init_do with -

combinational {true}:

smartpower_init_set_combinational_options -freq {10 MHz} -proba {20}

smartpower_init_set_enables_options

Initializes the clock frequency of all enable clocks with the initialization options.

smartpower_init_set_enables_options -freq {value} -proba {value}
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Arguments
-freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz).
-proba {value}

Specifies the user input probability in %.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all clocks after executing smartpower_init_do with -enables {true}:

smartpower_init_set _enables_options -freq {10 MHz} -proba {20}

smartpower_init_set_othersets_options

Initializes the frequency and probability of all other sets.

smartpower_init_set_othersets_options [-freq "decimal value [ unit { Hz | KHz | MHz } 1"]
[-proba *decimal value']

[-with *vectorless | default']

[-input_freq "decimal value [ unit { Hz | KHz | MHz } 1"1]

[-input_proba 'decimal value']

Arguments
-freq "decimal value [unit {Hz | KHz] MHz}"
Specifies the default frequency and units.
-proba {decimal value}
Specifies the default probability.
-with "vectorless | default"
Specifies vectorless or default analysis.
-input_freq "decimal value [unit {Hz | KHz] MHz}"
Specifies the input frequency and units.
—-input_proba {decimal value}

Specifies the input probability.
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Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize Frequencies and Probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all other sets after executing smartpower_init_do with -othersets {true}:

smartpower_init_set othersets_options -freq {10 MHz} -proba {20} [-with default]

smartpower_init_set_primaryinputs_options
Initializes the frequency and probability of all primary inputs.

smartpower_init_set_primaryinputs_options -freq {value} -proba {value}

Arguments
-freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and
toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-proba {value}
Specifies the user input probability in %.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all primary inputs after executing smartpower_init_do with -

primaryinputs {true}:

smartpower_init_set primaryinputs_options -freq {10 MHz} -proba {20}
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smartpower_init_set_registers_options
Initializes the frequency and probability of all register outputs.

smartpower_init_set_registers_options -freq {value} -proba {value}

Arguments
-freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and
toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-proba {value}

Specifies the user input probability in %.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all register outputs after executing smartpower_init_do with -registers
{true}:

smartpower_init_set registers_options -freq {10 MHz} -proba {20}

smartpower_init_set_set_reset_options

Initializes the frequency and probability of all set and reset nets.

smartpower_init_set_set_reset options -freq {value} -proba {value}

Arguments
-freq {value}

Specifies the user input frequency (in Hz, KHz, or MHz) or the toggle rate (in %). If the unit is not provided and
toggle rate is active, the value is handled as a toggle rate; if toggle rate is not active, the value is handled as a
frequency.

-proba {value}

Specifies the user input probability in %.
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Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all set/reset nets after executing smartpower_init_do with -set_reset

{true}:

smartpower_init_set _set reset options -freq {10 MHz} -proba {20}

smartpower_init_setofpins_values
Initializes the frequency and probability of all sets of pins.

smartpower_init_setofpins_values -domain_name {name} -freq {value} -proba {value}
Arguments

-domain_name{name}

Specifies the set of pins that will be initialized. The following table shows the acceptable values for this argument:

Value Description

IO0sEnableSet Specifies that the IOsEnableSet set of pins will be initialized

MemoriesEnableSet Specifies that the MemoriesEnableSet set of pins will be

initialized

-freq {value}

Specifies the user input frequency in Hz, MHz, or KHz.
-proba {value}

Specifies the user input probability in %.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
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Exceptions

e None

Examples
The following example initializes all primary inputs after executing smartpower_init_do with -othersets
{true}:

smartpower_init_setofpins_values -domain_name {l0skEnableSet} -freq {10 MHz} -proba {20}

smartpower_remove_all_annotations

Removes all initialization annotations for the specified mode.

smartpower_remove_all_annotations -opmode {value}

Arguments
-opmode {value}

Removes all initialization annotations for the specified mode.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize frequencies and probabilities dialog box.
Exceptions

e None
Examples

The following example initializes all clocks withs:

smartpower_remove_all_annotations -opmode {my_mode}

smartpower_remove_custom_mode

Removes a custom mode.
smartpower_remove_custom_mode -name {deleted_mode_name}
Arguments

-name {deleted_mode_name}

Specifies the name of the custom mode you want to delete.
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Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example delets custom mode "Cust_1":
smartpower_delete_custom _mode -name {Cust_ 1}
See Also

sp_add_custom_mode
sp_edit_custom _mode

smartpower_remove_domain

Removes an existing clock or set domain.
smartpower_remove_domain -domain_type {value} -domain_name {domain_name}
Arguments

-domain_type {value}

This specifies the type of domain to remove. The following table shows the acceptable values for this argument:

Value Description

clock The domain is a clock domain

set The domain is a set domain

-domain_name {domain_name}

This specifies the name of the domain to remove

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes
The domain name must be the name of an existing domain.

The domain type must be either clock or set.
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Exceptions
None

Examples
The following example removes the clock domain named "clk2":
smartpower_remove_domain -domain_type {clock} -domain_name {clk2}
The following example removes the set domain named "myset":
smartpower_remove_domain -domain_type {set} -domain_name {myset}

See Also

smartpower_create_domain

smartpower_remove_file
Removes a VCD file from the specified mode.

remove_File

[-File {value}] \
[-format {value}] \
[-opmode {value}] \

Arguments

-file {value}

Specifies the file to be removed.

-format VCD

Specifies that the type to be removed is a VCD file.

-opmode {value}

Specifies the operating mode. The following table shows the acceptable values for this argument:

Value Description

active The operating mode is set to active
static The operating mode is set to static
sleep The operating mode is set to sleep
Flash*Freeze The operating mode is set to Flash*Freeze
shutdown The operating mode is set to shutdown

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator
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Notes

e Noe
Exceptions

e Nonne
Examples

This example removes the file test.ved from the active mode.

smartpower_remove_file -file test -format -vcd opmode -active

smartpower_remove_pin_probability
Removes the probability value associated with a specific pin. This pin will have a default probability based on the

domain set it belongs to.
smartpower_remove_pin_probability —pin_name {pin_name}
Arguments

-pin_name {pin_name}

Specifies the name of the pin with the probability to remove. This pin must be the direct driver of an enable pin.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example removes the probability of the pin driving the enable pin of a bidirectional 1/O:

Smartpower_remove_pin_probability —pin_name mybibuf/U0/U1:EOUT

See Also
smartpower_set_pin_probability

smartpower_remove_pin_frequency

Removes the frequency associated with a specific pin. This pin will have a default frequency based on its domain.

smartpower_remove_pin_frequency -pin_name {pin_name}
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smartpower_remove_pin_of_domain

Arguments
-pin_name {pin_name}
Specifies the name of the pin for which the frequency will be removed.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e The pin_name must be the name of a pin that already exists in the design and already belongs to a domain.
Exceptions

e None
Examples

The following example removes the frequency from the pin named "count8_clock":

smartpower_remove_pin_frequency -pin_name {count8 clock}

See Also
smartpower_set pin_frequency

smartpower_remove_pin_of_domain

Removes a clock pin or a data pin from a clock or set domain, respectively.

smartpower_remove_pin_of _domain -pin_name {pin_name} -pin_type {value} -domain_name
{domain_name} -domain_type {value}

Arguments
-pin_name {pin_name}
Specifies the name of the pin to remove from the domain.
-pin_type {value}
Specifies the type of the pin to remove. The following table shows the acceptable values for this argument:
Value Description
clock The pin to remove is a clock pin
data The pinto remove is a data pin

-domain_name {domain_name}
Specifies the name of the domain from which to remove the pin.
-domain_type {value}
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Specifies the type of domain from which the pin is being removed. The following table shows the acceptable values
for this argument:

Value Description
clock The domain is a clock domain
set The domain is a set domain

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes
e The domain name must be the name of an existing domain.
e The pin name must be the name of an existing pin.
Exceptions
e None
Examples

The following example removes the clock pin named "XCMP3/UO/U1:Y" from the clock domain named "clockh":

smartpower_remove_pin_of _domain -pin_name {XCMP3/U0/U1:Y}

-pin_type {clock} -domain_name {clockh} -domain_type {clock}

The following example removes the data pin named "count2_en" from the set domain named "InputSet":
smartpower_remove_pin_of _domain -pin_name {count2_en} -pin_type

{data} -domain_name {InputSet} -domain_type {set}

See Also
smartpower_add pin_in_domain

smartpower_remove_scena rio

Remmoves a scenario from the current design.
smartpower_remove_scenario -name {value}
Arguments

-name {value}

Specifies the name of the scenario.
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smartpower_remove_vcd

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example removes a scenario from the current design:

smartpower_remove_scenario -name myscenario

smartpowe r_remove_vcd

Removes an existing VCD file from a mode or entire design.

smartpower_remove_vcd -from {value} -mode {value} -Ffile

Arguments
-from {value}

This specifies the if the VCD is removed for a specific mode or for the entire project. The following table shows the
acceptable values for this argument:

Value Description

mode The VCD file is removed for a mode

project The VCD file is removed from the project

-mode {value}

This specifies the name of the mode for which the VCD will be removed
-filename

This specifies the name of the VCD file to be removed

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

None
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Exceptions
None
Examples
The following example removes the VCD file named my_vcd.vcd from the active mode
smartpower_remove_vcd -from {mode} -mode {active} -my_vcd.vcd
See Also

smartpower_create_domain

smartpower_restore

Restores all power information previously committed in SmartPower.

smartpower_restore

Arguments

e None

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

smartpower_restore

See Also
smartpower_commit

smartpower_set_battery_capacity
Sets the battery capacity.

smartpower_set_battery_capacity {value}
Arguments

value

Sets the battery capacity to a value in mA/h.
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Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example sets the battery capacity to 40 A/h:

smartpower_set_battery capacity {40}

smartpower_set_cooling

Sets the cooling style to one of the predefined types, or a custom value.

smartpower_set_cooling -style {value} -teta {value}

smartpower_set_cooling

Arguments
-style {value}
Specifies the cooling style to custom value or to one of the predefined types with a default thermal resistance value.
The following table shows the acceptable values for this argument:
Value Description
300_1fm Predefined cooling style
case_cooling Predefined cooling style
still_air Predefined cooling style
custom Cooling style defined by user input

-teta {value}

Specifies the thermal resistance in °C/W. This argument is only available when style is set to Custom.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator
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Notes
e To compute the junction temperature, set the following three commands: smartpower set thermalmode,
smartpower set tambient and smartpower set cooling. The junction temperature will be updated when an
output command is executed, such as report(Power).
Exceptions
e None
Examples

The following example sets the cooling style to still air:

smartpower_set _cooling -style {still_air}

smartpower_set_mode_for_analysis

Sets the mode for cycle-accurate power analysis.

smartpower_set _mode_for_analysis -mode {value}

Arguments
-mode {value}

Specifies the mode for cycle-accurate power analysis.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example sets the mode for analysis to active:

smartpower_set_mode_for_analysis -mode {active}

smartpower_set_operating_condition

Sets the operating conditions used in SmartPower to one of the pre-defined types.

smartpower_set_operating_condition -opcond {value}
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Arguments
-opcond {value}
Specifies the value of the operating condition. The following table shows the acceptable values for this argument:

Value Description

best Sets the operating conditions to best

typical Sets the operating conditions to typical

worst Sets the operating conditions to worst

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example sets the operating conditions to best:

smartpower_set_operating_condition -opcond {best}

smartpower_set_pin_frequency

Sets the frequency of a pin in megahertz (MHz). If you do not use this command, each pin will have default

frequency based on its domain.

smartpower_set_pin_frequency -pin_name {pin_name} -pin_freq {value}

Arguments
-pin_name {pin_name}
Specifies the name of the pin for which the frequency will be set.
-pin_freq {value}

Specifies the value of the frequency in MHz, which can be any positive decimal number.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator
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Notes
e The pin_name must be the name of a pin that already exists in the design and already belongs to a domain.
e  When specifying the unit, a space must be between the frequency value and the unit.

Exceptions
e None

Examples

This example sets the frequency of the pin named "count8_clock" to 100 MHz:

smartpower_set _pin_frequency -pin_name {count8 clock} -pin_freq {100}

See Also
smartpower_remove_pin_frequency

smartpower_set_pin_probability

Enables you to set the probability value of a pin driving an enable pin. For I/Os, if you do not use this command, the
probability of the IOEnableSet is used. For memories, if you do not use this command, the probability of the

MemoriesEnableSet is used.

smartpower_set _pin_probability -pin_name {pin_name} —pin_enable_rate {value}

Arguments
-pin_name {pin_name}
Specifies the name of a pin for which the probability will be set. This pin must be the direct driver of an enable pin.
-pin_proba {value}

Specifies the value of the pin probability as a percentage, which can be any positive decimal between 0 and 100,
inclusive.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example sets the probability of the pin driving the enable pin of a bidirectional I/O

smartpower_set_pin_probability -pin_name mybibuf/U0O/U1:EOUT \
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—pin_proba 50.4

See Also
smartpower_remove_pin_probability

smartpower_set_p references

Sets the following preferences: power unit, frequency unit, operating mode, operating conditions, and toggle. These

preferences can also be set from the preferences dialog box.

smartpower_set_preferences -powerunit {value} -frequnit {value} -opmode {value} -opcond
{value} -toggle {value}

Arguments
-powerunit {value}
Specifies the unit in which power is set. The following table shows the acceptable values for this argument:
Value Description
W The power unit is set to watts
mW The power unit is set to milliwatts
uW The power unit is set to microwatts
-frequnit {value}
Specifies the unit in which frequency is set. The following table shows the acceptable values for this argument:
Value Description
Hz The frequency unit is set to hertz
kHz The frequency unit is set to kilohertz
MHz The frequency unit is set to megahertz
-opmode {value}
Specifies the operating mode. The following table shows the acceptable values for this argument:
Value Description
active The operating mode is set to active
static The operating mode is set to static
sleep The operating mode is set to sleep
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Value Description
Flash*Freeze The operating mode is set to Flash*Freeze
shutdown The operating mode is set to shutdown

-opcond {value}
Specifies the operating condition. The following table shows the acceptable values for this argument:

Value Description
worst The operating condition is set to worst case
typical The operating condition is set to typical case
best The operating condition is set to best case

-toggle {value}
Specifies the toggle. The following table shows the acceptable values for this argument:

Value Description

true The toggle is set to true

false The toggle is set to false

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes
e The following arguments have been removed. Running the script will trigger a warning message: Warning:

Invalid argument: -argname "argvalue" Ignored. Ignore the warning.

-maxblocks {integer > 0}

-maxpins [{integer > 0}

-sortorder {ascending, descending}
-sortby {powervalues, alphabetical}

o Flash*Freeze, Sleep, and Shutdown are available only for certain families and devices.

e  Worst and Best operating conditions are available only for certain families and devices.
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Exceptions
e None
Examples
This example sets the frequency of the power unit to "watts", the frequency unit to "Hz", the operating mode to
"active", the operating condition to "typical", and the toggle to "true":
smartpower_set_setpreferences -powerunit {w} -frequnit {hz} -opmode {active} -opcond
{typical} -toggle {true}
See Also

SmartPower Preferences

smartpower_set_scenario_for_analysis

Sets the scenario for cycle-accurate power analysis.

smartpower_set _scenario_for_analysis -scenario{value}

Arguments
-scenario {value}

Specifies the mode for cycle-accurate power analysis.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example sets the scenario for analysis to my_scenario:

smartpower_set_scenario_for_analysis -scenario {my_scenario}

smartpower_set_temperature_opcond

Sets the temperature in the operating conditions to one of the pre-defined types.

smartpower_set_temperature_opcond -use{value}
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Arguments
-use{value}
Specifies the temperature in the operating conditions. The following table shows the acceptable values for this
argument:
Value Description
oprange Sets the temperature in the operating conditions as specified in
the Device Selection Wizard in Designer
design Sets the temperature in the operating conditions as specified in
the SmartPower design-wide operating range. Applies to
SmartPower only.
mode Sets the temperature in the operating conditions as specified in
the SmartPower mode-specific operating range. Applies to
SmartPower only.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example sets the temperature in the operating conditions as specified in the custom mode-settings:

smartpower_set_temperature_opcond -use{mode}

smartpower_set_thermalmode

Sets the mode of computing junction temperature.

smartpower_set thermalmode -mode {value}

Arguments
-mode {value}

Specifies the mode in which the junction temperature is computed. The following table shows the acceptable values
for this argument:
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Value Description

ambient The junction temperature will be iteratively computed with total

static power

opcond The junction temperature will be given as one of the operating

condition range values specified in the device selection

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes
e To compute the junction temperature, set the following three commands: smartpower set thermalmode,
smartpower set tambient and smartpower set cooling. The junction temperature will be updated when an
output command is executed, such as report(Power).
Exceptions
e None
Examples

The following example sets the computing of the junction temperature to ambient mode:

smartpower_set_thermalmode -mode {ambient}

smartpower_set_voltage_opcond

Sets the voltage in the operating conditions.

smartpower_set_voltage _opcond -voltage{value} -use{value}

Arguments
-voltage{value}
Specifies the voltage supply in the operating conditions. The following table shows the acceptable values for this
argument:
Value Description

VCCA Sets the voltage operating conditions for VCCA

VCCI 3.3 Sets the voltage operating conditions for VCCI 3.3

VCCI 2.5 Sets the voltage operating conditions for VCCI 2.5
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Value Description
VCCI 1.8 Sets the voltage operating conditions for VCCI 1.8
VCCI 1.5 Sets the voltage operating conditions for VCCI 1.5
VCC33A Sets the voltage operating conditions for VCC33A
VCCDA Sets the voltage operating conditions for VCCDA
-use{value}

Specifies the voltage in the operating conditions for each voltage supply. The following table shows the acceptable
values for this argument:

Value Description

oprange Sets the voltage in the operating conditions as specified in the
prang g P g P

Device Selection Wizard in Designer

design Sets the voltage in the operating conditions as specified in the
SmartPower design-wide operating range. Applies to

SmartPower only.

mode Sets the voltage in the operating conditions as specified in the
SmartPower mode-specific operating range. Applies to

SmartPower only.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example sets the VCCA as specified in the SmartPower mode-specific settings:

smartpower_set_voltage opcond -voltage{vcca} -use{mode}
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smartpower_temperature_opcond_set_design_wide

Sets the temperature for SmartPower design-wide operating conditions.

smartpower_temperature_opcond_set_design_wide -best{value} -typical{value} -worst{value} -
thermal_mode{value}

Arguments
-best{value}
Specifies the best temperature (in degrees Celsius) used for design-wide operating conditions.
-typical{value}
Specifies the typical temperature (in degrees Celsius) used for design-wide operating conditions.
-worst{value}
Specifies the worst temperature (in degrees Celsius) used for design-wide operating conditions.
-thermal_mode{value}

Specifies the mode in which the junction temperature is computed. The following table shows the acceptable values
for this argument:

Value Description

ambient The junction temperature will be iteratively computed with total

static power

opcond The junction temperature will be given as one of the operating

condition range values specified in the device selection

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

This example sets the temperature for design-wide operating conditions to Best 20, Typical 30, and Worst 60:

smartpower_temperature_opcond_set design_wide -best{20} -typical{30} -worst{60}

smartpower_temperature_opcond_set_mode_specific

Sets the temperature for SmartPower mode-specific operating conditions.
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smartpower_temperature_opcond_set_mode_specific -mode{value} -best{value} -typical{value} -
worst{value} -thermal_mode{value}

Arguments

-mode{value}

Selects the mode to which apply the operating condition settings. You can select a pre-defined mode or any custom
mode in your design.

-best{value}

Specifies the best temperature (in degrees Celsius) for the selected mode.

-typical{value}

Specifies the typical temperature (in degrees Celsius) for the selected mode.

-worst{value}

Specifies the worst temperature (in degrees Celsius) for the selected mode.

-thermal_mode{value}

Specifies the mode in which the junction temperature is computed. The following table shows the acceptable values
for this argument:

Value Description

ambient The junction temperature will be iteratively computed with total

static power

opcond The junction temperature will be given as one of the operating

condition range values specified in the device selection

Supported Families

IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes
e None

Exceptions
e None

Examples
This example sets the temperature for mode-specific operating conditions for model:
smartpower_temperature_opcond_set_mode_specific -mode{model} -best{20} -typical{30} -
worst{60}
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smartpower_voltage_opcond_set_design_wide

Sets the voltage settings for SmartPower design-wide operating conditions.

smartpower_voltage opcond_set design_wide -voltage{value} -best{value} -typical{value} -

worst{value}
Arguments

-voltage{value}

Specifies the voltage supply in the operating conditions. The following table shows the acceptable values for this

argument:

Value Description
VCCA Sets the voltage operating conditions for VCCA
VCCI 3.3 Sets the voltage operating conditions for VCCI 3.3
VCCI 2.5 Sets the voltage operating conditions for VCCI 2.5
VCCI 1.8 Sets the voltage operating conditions for VCCI 1.8
VCCI 1.5 Sets the voltage operating conditions for VCCI 1.5
VCC33A Sets the voltage operating conditions for VCC33A
VCCDA Sets the voltage operating conditions for VCCDA
-best{value}
Specifies the best voltage used for design-wide operating conditions.
-typical{value}

Specifies the typical voltage used for design-wide operating conditions.
-worst{value}

Specifies the worst voltage used for design-wide operating conditions.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None

Exceptions

e None
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Examples
This example sets VCCA for design-wide to best 20, typical 30 and worst 40:

smartpower_voltage opcond_set_design_wide -voltage{VCCA} -best{20} -typical{30} -
worst{40}

smartpower_voltage_opcond_set_mode_specific

Sets the voltage settings for SmartPower mode-specific use operating conditions.

smartpower_voltage_opcond_set_mode_specific -opmode{value} -voltage{value} -best{value} -
typical{value} -worst{value}

Arguments
-opmode{value}

Selects the mode to which apply the operating condition settings. You can select a pre-defined mode or any custom
mode in your design.

-voltage{value}
Specifies the voltage in the operating conditions. The following table shows the acceptable values for this argument:

Value Description

VCCA Sets the voltage operating conditions for VCCA

VCCI 3.3 Sets the voltage operating conditions for VCCI 3.3

VCCI2.5 Sets the voltage operating conditions for VCCI 2.5

VCCI 1.8 Sets the voltage operating conditions for VCCI 1.8

VCCI 1.5 Sets the voltage operating conditions for VCCI 1.5

VCC33A Sets the voltage operating conditions for VCC33A

VCCDA Sets the voltage operating conditions for VCCDA

-best{value}
Specifies the best voltage used for mode-specific operating conditions.
-typical{value}
Specifies the typical voltage used for mode-specific operating conditions.
-worst{value}

Specifies the worst voltage used for mode-specific operating conditions.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator
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Notes

e None
Exceptions

e None
Examples

This example sets the voltage for the static mode and sets best to 20, typical to 30 and worst to 40:

smartpower_voltage _opcond_set_mode_specific -opmode{active} -voltage{VCCA} -best{20} -
typical{30} -worst{40}

SmartPower Obsolete TCL Commands

smartpower _initialize_allclocks

This command was obsoleted in SmartPower v8.5. Update your script to use:

smartpower init set clocks options to initialize the clock frequency options of all clock domains.

smartpower init set registers options to initialize the frequency and probability of all register outputs.

smartpower init set set reset options to initialize the frequency and probability of all set/reset nets.

smartpower init set primaryinputs options to initialize the frequency and probability of all primary inputs.

smartpower init set combinational options to initialize the frequency and probability of all combinational outputs.

smartpower_init do to initialize the frequencies and probabilities for clocks, register outputs, set/reset nets, primary

inputs, combinational outputs, enables and other sets of pins, and selects a mode for initialization.

Note: Note: The information below is obsolete and should only be used as reference. Update your scripts to use the

TCL commands above.

Initializes the clock frequency and the data frequency of all clock domains with the initialization options.

smartpower_initialize_allclocks -with_clock constraints {value} -with_clock freq {value} -
clock _freq {value} -with_data freq {value} -data_ freq {value}

Arguments
-with_clock_constraints {value}

This sets the option of initializing the clock frequencies of all clock domains with frequency constraints from
SmartTime. The following table shows the acceptable values for this argument:

Value Description

true Sets initialize clock frequencies with clock constraints ON

false Sets initialize clock frequencies with clock constraints OFF
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-with_clock_freq {value}

This sets the option of initializing the clock frequencies with a user input frequency. The following table shows the
acceptable values for this argument:

Value Description
true Sets initialize clock frequencies with fixed frequency ON
false Sets initialize clock frequencies with fixed frequency OFF

-clock_freq {value}
Specifies the user input clock frequency in MHz.
-with_data_freq {value}

Sets the option of initializing the data frequencies of all clock domains with a user input toggle rate or a user input
frequency. The following table shows the acceptable values for this argument:

Value Description
true Sets initialize data frequencies with fixed frequency ON
false Sets initialize data frequencies with fixed frequency OFF

-data_freq {value}

Specifies the user input toggle rate or data frequency. If the value is a percentage number such as 20.0 %, it will be
interpreted as a toggle rate. If the value is a decimal number in MHz such as 100.0 MHz, it will be interpreted as a
fixed frequency value.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e This command is associated with the functionality of Initialize with SmartTime dialog box.
Exceptions

e None
Examples

The following example initializes all clocks with clock constraints from SmartTime:

smartpower_initialize_allclocks -with_clock_constraints {true}
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smartpower_remove_pin_enable_rate
This command was obsoleted in SmartPower v8.5. Update your script to use
smartpower_remove_pin_probability toremove the pin probability.
Note: Note: The information below is obsolete and should only be used as reference when executing previously-
created scripts. Update your scripts to use Smartpower_remove_pin_probability.

Removes the probability value associated with a specific pin. This pin will have a default probability based on the

domain set it belongs to.

smartpower_remove_pin_enable_rate —pin_name {pin_name}

Arguments
-pin_name {pin_name}
Specifies the name of the pin with the probability to remove. This pin must be the direct driver of an enable pin.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example removes the probability of the pin driving the enable pin of a bidirectional 1/0:

Smartpower_remove_pin_enable_rate —pin_name mybibuf/U0/U1:EOUT

smartpower_set_default_enable_rate
This command was obsoleted in SmartPower v8.5. Update your script to use

smartpower_change_setofpin_statistics to set the frequency and probability of the specified domain.

Note: Note: The information below is obsolete and should only be used as reference when executing previously-

created scripts. Update your scripts to use smartpower_change_setofpin_statistics.

Sets the enable-rate of one of the enable set domains: IOEnableSet or MemoriesEnableSet.

smartpower_set_default_enable_rate —domain_name {name} pin_enable_rate {value}

Arguments
—domain_name {name}

Specifies the name of the domain value of which you want to apply the enable rate value. The domain_name can be

IOsEnableSet or MemoriesEnableSet.
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-pin_enable_rate {value}

Specifies the value of the pin enable rate as a percentage, which can be any positive decimal between 0 and 100,
inclusive.

Supported Families
IGLOO, Fusion, ProASIC3, ProASICPUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example sets the enable rate for all the pins belonging to the domain set IOsEnableSet:

smartpower_set_default_enable_rate -domain_name 10skEnableSet —pin_enable_rate 52.2

smartpower_set_domain_frequency

This command was obsoleted in SmartPower v8.5. Update your script to use:

smartpower change setofpin_statistics to change the frequencies and probabilities for all sets of pins in a specific

domain

smartpower change clock statistics to change the frequencies and probabilities for all clocks in a specific domain
Note: Note: The information below is obsolete and should only be used as reference when executing previously-
created scripts. Update your scripts to use the TCL commands above.
Sets the frequency of a domain in megahertz (MHz).

smartpower_set_domain_frequency -domain_type {value} -domain_name {domain_name} -clock_freq
{value} -data_freq {value} -pin_freq {value}

Arguments
-domain_type {value}

Specifies the type of domain to set. The following table shows the acceptable values for this argument:

Value Description

clock The domain is a clock domain

set The domain is a set domain

-domain_name {domain_name}
Specifies the name of the domain for which the frequency will be set.
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-clock_freq {value}

Specifies the clock frequency in megahertz (MHz), which can be any positive decimal number. This argument is
available only for a clock domain.

-data_freq {value}

Specifies the data frequency in megahertz (MHz), which can be any positive decimal number. This argument is
available only for a clock domain.

-pin_freq {value}

Specifies the value of the pin frequency in megahertz (MHz), which can be any positive decimal number, which can
be any positive decimal number. This argument is available only for a set domain.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPUS ProASIC, and Axcelerator

Notes

e The domain type must be either clock or sez.

e The domain name must be the name of an existing domain.

e The clock frequency must be a positive decimal number. Specifying the unit as part of the frequency value is
optional. You must enter a space between the frequency value and the unit. You set the clock frequency only for
clock domains.

e The data frequency must be a positive decimal number. Specifying the unit as part of the data frequency value is
optional. You must enter a space between the data frequency value and the unit.

Exceptions
e None
Examples

The following example sets the clock and data frequency of a clock domain:

smartpower_set_domain_frequency —domain_type {clock} —domain_name {clkl} —clock_freq
{32} or {30 MHz} —data_freq {3} or {3 MHz}

The following example sets the data frequency of a set domain:

smartpower_set_domain_frequency —domain_type {set} —domain_name {setl} —data_freq {10}

smartpower_set_pin_enable_rate
This command was obsoleted in SmartPower v8.5. Update your script to use smartpower_set_pin_probability
to set the pin probability.
Note: Note: The information below is obsolete and should only be used as reference when executing previously-

created scripts. Update your scripts to use smartpower set pin probability.
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Enables you to set the probability value of a pin driving an enable pin. For I/Os, if you do not use this command, the
probability of the IOEnableSet is used. For memories, if you do not use this command, the probability of the

MemoriesEnableSet is used.

smartpower_set_pin_enable_rate -pin_name {pin_name} —pin_enable_rate {value}

Arguments
-pin_name {pin_name}
Specifies the name of a pin for which the probability will be set. This pin must be the direct driver of an enable pin.
-pin_enable_rate {value}

Specifies the value of the pin probability as a percentage, which can be any positive decimal between 0 and 100,
inclusive.

Supported Families
IGLOO, ProASIC3, SmartFusion, Fusion, ProASICPLUS ProASIC, and Axcelerator

Notes

e None
Exceptions

e None
Examples

The following example sets the probability of the pin driving the enable pin of a bidirectional I/O

smartpower_set_pin_enable_rate -pin_name mybibuf/UO/U1:EOUT \
—pin_enable_rate 50.4

Data Change History - SmartPower
The data change history report lists power data updates up to the current release that may impact the power

consumption of the design.

To generate a data change history report, from the Help menu, choose Data Change History. This opens a data

change history report in text format.
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Product Support

Actel backs its products with various support services including Customer Service, a Customer Technical Support
Center, a web site, an FTP site, electronic mail, and worldwide sales offices. This appendix contains information about
contacting Actel and using these support services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades, update
information, order status, and authorization.

From Northeast and North Central U.S.A., call 650.318.4480
From Southeast and Southwest U.S.A., call 650. 318.4480
From South Central U.S.A., call 650.318.4434

From Northwest U.S.A., call 650.318.4434

From Canada, call 650.318.4480

From Europe, call 650.318.4252 or +44 (0) 1276 401 500
From Japan, call 650.318.4743

From the rest of the world, call 650.318.4743

Fax, from anywhere in the world 650. 318.8044

Actel Customer Technical Support Center

Actel staffs its Customer Technical Support Center with highly skilled engineers who can help answer your hardware,
software, and design questions. The Customer Technical Support Center spends a great deal of time creating
application notes and answers to FAQs. So, before you contact us, please visit our online resources. It is very likely we
have already answered your questions.

Actel Technical Support

Visit the Actel Customer Support website (http://www.actel.com/support/search/default.aspx) for more information
and support. Many answers available on the searchable web resource include diagrams, illustrations, and links to other
resources on the Actel web site.

Website

You can browse a variety of technical and non-technical information on Actel’s home page, at http://www.actel.com/.

Contacting the Customer Technical Support Center

Highly skilled engineers staff the Technical Support Center from 7:00 A.M. to 6:00 P.M., Pacific Time, Monday
through Friday. Several ways of contacting the Center follow:

Email

You can communicate your technical questions to our email address and receive answers back by email, fax, or phone.
Also, if you have design problems, you can email your design files to receive assistance. We constantly monitor the
email account throughout the day. When sending your request to us, please be sure to include your full name, company
name, and your contact information for efficient processing of your request.
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The technical support email address is tech@actel.com.

Phone

Our Technical Support Center answers all calls. The center retrieves information, such as your name, company name,
phone number and your question, and then issues a case number. The Center then forwards the information to a queue
where the first available application engineer receives the data and returns your call. The phone hours are from 7:00
A.M. to 6:00 P.M., Pacific Time, Monday through Friday. The Technical Support numbers are:

650.318.4460
800.262.1060
Customers needing assistance outside the US time zones can either contact technical support via email

(tech@actel.com) or contact a local sales office. Sales office listings can be found at
www.actel.com/company/contact/default.aspx.
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Actel is the leader in low-power and mixed-signal FPGAs and offers the most comprehensive
portfolio of system and power management solutions. Power Matters. Learn more at
http://www.actel.com .

Actel Corporation « 2061 Stierlin Court ® Mountain View, CA 94043 ¢ USA
Phone 650.318.4200 * Fax 650.318.4600 * Customer Service: 650.318.1010  Customer Applications Center: 800.262.1060

Actel Europe Ltd.  River Court, Meadows Business Park e Station Approach, Blackwater « Camberley Surrey GU17 9AB ¢ United Kingdom
Phone +44 (0) 1276 609 300  Fax +44 (0) 1276 607 540

Actel Japan ¢ EXOS Ebisu Building 4F ¢ 1-24-14 Ebisu Shibuya-ku ¢ Tokyo 150 ¢ Japan
Phone +81.03.3445.7671 o Fax +81.03.3445.7668 * http://jp.actel.com

Actel Hong Kong * Room 2107, China Resources Building ® 26 Harbour Road ® Wanchai ® Hong Kong
Phone +852 2185 6460 © Fax +852 2185 6488 » www.actel.com.cn
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